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xii Using This Guide

 Introduction to Preps

Who Should Use This Guide
This guide is intended as an introduction to Preps 5.0 for new users. It 
covers most of the features and functionality of Preps. 

To use this guide, you should:

• Have a working knowledge of prepress operations

• Be familiar with the Windows operating system

• Be familiar with the Macintosh operating system

This guide assumes that:

• All the hardware, software, and network components of your system 
are installed, configured, and operating correctly.

• Files submitted to Preps are free of common errors usually resolved 
during preflight, such as missing fonts and PostScript® errors.

Guiding Principles
This self-study guide incorporates the following adult learning principles:

• Provides conceptual ideas to provide clarity of where training fits in 
the larger picture

• Provides realistic examples connecting training to real world working 
environments

• Relates training to what learners already know

• Incorporates hands-on practice to enable learning by doing

• Provides scope of training through learning objectives

• Relates hands-on activities to stated learning objectives

For more detailed information, refer to the Preps 5.0 User Guide, which is 
available in PDF (Portable Document Format) on the Preps 5.0 CD.
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Self-Study Guide Objectives xiii

Self-Study Guide Objectives
As a new user, this self-study guide will help you learn to:

• Create and modify a basic Preps job

• Select signatures for a Preps job

• Use placeholders

• Configure devices and preferences

• Create templates

• Add and configure marks

• Preview Preps jobs

• Apply page adjustments

• Apply fitting and tiling options

• Print PostScript and PDF jobs out of Preps

PDF Document
This guide is also provided in PDF.

The PDF document can be used for online viewing and printing using 
Adobe Acrobat® Reader. When printing the guide, please print the entire 
guide, including the copyright and disclaimer statements.

For More Information
Visit www.creo.com for documentation, training courses, downloads, and 
service and support contacts.

http://www.creo.com
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Module Objectives
By the end of this module, you will be able to:

• Create a basic Preps job

• Add source files to the file list

• Add pages to the run list

• Modify the file list and run list

• Add signatures to a job

• Save and name a job
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Creating a Basic Preps Job

Overview
Preps accepts PostScript®, EPS, TIFF, DCS, and PDF source files from 
more than 120 applications. Preps Pro and Preps XL for Windows accept 
Xerox RDO files. You can mix any combination of these files within a job.

There are two types of jobs you can create in Preps:

• Mixed source files with PostScript output

• PDF source files with PDF output

From the File menu, choose New Job > Mixed Files -> PostScript or 
New Job > PDF -> PDF.

Important:  Preps 5.0 cannot run when Classic mode is active. Stop Classic 
mode and restart Preps.
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When you create a Preps job, three empty job windows open on screen:

• File List window

• Run List window

• Signature List window

When you add source files to a Preps job, these job windows contain 
information about the source file, the source file pages, and the selected 
layout.

File List Window
The file list contains the source files used in a job. Adding source files to the 
file list makes them available for use in the current job, but you do not have 
to use all the files in the file list, nor do you have to use all of the pages in 
each of the files. It does not matter what order files appear in the file list.

Run List Window
The run list is where you arrange the pages in the final printed order, from 
the beginning to the end. For example, the run list for a small booklet 
might be set up like this:

Outside front cover

Inside front cover

Page 1

Page 2

Page 3

Page 4

Inside back cover

Outside back cover

Signature List Window
The signature list is where the signatures used for the impositions are listed 
in the order in which the job will be assembled. 
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Saving Window Positions
You can customize the job window sizes and positions, and save them as 
the default.

From the Windows menu, choose Save Window Positions.

Adding Source Files to the File List
There are three ways to add files to the file list:

• Click Add Files in the File List window.

• From the Job menu, choose Add Files.

• Drag and drop files from the Macintosh Finder or Windows Explorer 
into the File List window.

Information about the source files appears in the File List window: the file 
name, number of pages in the file, and the page size. Icons representing 
each page in the source file appear on the right side of the File List window.

Adding Pages to the Run List
There are three ways to add pages to the run list:

• Select the Add all pages to run list check box when you add source files 
to the file list using Add Files.

• Drag and drop files or pages from the file list to the run list.

• Drag and drop files from the Macintosh Finder or Windows Explorer 
to the run list; if the file is not already present in the file list, it 
automatically appears in the file list.
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Adding Blank Pages to the Run List
You can add blank pages to the run list. For example, if the first chapter in 
a book contains seven pages and you want the second chapter to start on an 
odd-numbered page, you can add a blank page in between the first and 
second chapters to force the second chapter to start on page nine.

Adding a Single Blank Page to the Run List

Drag the Blank page icon from the top of the Run List window to the 
position in the run list where you want to add the page.

Adding Multiple Blank Pages to the Run List

1. Press and hold the SHIFT key as you click and drag the Blank page icon 
to the run list.

2. The Add Blank Pages dialog box appears. In the Number of pages 
box, type the number of blank pages you want to add.

3. Click OK.
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Modifying the File List and the Run List
You can add and remove files in the file list, and add, remove, and 
rearrange pages in the run list.

Selecting Pages in the File List and the Run List

Selecting a Range of Consecutive Pages

1. Click the first page you want to select in the file or the run list.

2. Press and hold the SHIFT key, then click the last page you want to 
select.

Selecting Multiple Non-Consecutive Pages

1. Click the first page you want to select in the file or the run list.

2. Press and hold the COMMAND key (Macintosh) or CONTROL key 
(Windows), then click the additional pages you want to select.

Selecting Pages Using the Select Page Range Dialog Box

1. From the Edit menu, choose Select Page Range.

2. Select All pages, Even pages, Odd pages, or Other. If the File List 
window is active, these options apply to the currently selected file. If 
the Run List window is active, these options apply to the pages in the 
run list. When you select Other, you type the page range you want to 
select. A range of consecutive numbers is indicated with a hyphen. 
Non-consecutive numbers are separated by a comma.
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Removing a Source File From the File List

Select the file you want to remove, then press the DELETE key. Preps 
displays a message to confirm that you want to delete the file. When a 
source file is removed from the file list, its pages are also removed from 
the run list.

Removing Pages From the Run List

Select the page(s) you want to remove and press the DELETE key. 
Removing pages from the run list does not remove pages or files from 
the file list.

Editing the Run List
You can move pages in the run list by dragging and dropping them to new 
positions, or by cutting or copying, and pasting them. You can create a 
copy of a run list page by pressing and holding the OPTION key while 
dragging and dropping the page to another position in the run list.

You can replace a page in the run list by dragging a new page from the file 
list (or from the Finder or Explorer) and dropping it onto the page you 
want to replace.

Adding Signatures to a Job
When all the pages are in the run list in the correct order, the next step is to 
select a template to produce imposed output. Preps then flows the run list 
pages through the signatures in the signature list.

Preps ships with a number of templates that contain commonly used 
layouts for different binding styles. You can modify these, or create your 
own.

1. In the Signature List window, click Signatures. The Signature Selection 
dialog box appears.
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2. From the Binding Style list, select the binding style for the job. Preps 
supports five binding styles:

• Flat work

• Perfect bound

• Saddle stitched

• Come ’n’ go

• Cut and stack

The binding style determines the order in which the job pages flow 
through the signatures. Once you select a binding style, templates 
created with that binding style are available for selecting in the 
Signature Selection dialog box. For more information about binding 
styles, see Selecting a Binding Style on page 56.

3. Select the template you want to use. Templates can contain multiple 
signatures. There are two ways to add signatures to a job:

• Automatically
Select the template name in the Signature Selection dialog box, 
then click Auto Select. Preps automatically flows the run list pages 
through the largest signature in the template, reusing the layout as 
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many times as needed until there are no longer enough pages to fill 
it. Preps then uses smaller signatures that most closely match the 
number of remaining run list pages. If there are not enough pages 
to fill the final signature, Preps leaves the missing pages empty.

• Manually
To add signatures manually, click the disclosure arrow next to the 
template name in the Signature Selection dialog box. Select the 
signature you want to use, then click Add. There is no limit to the 
number of signatures you can add in this manner, so it is possible 
to create empty signatures.

4. Once you have selected the signatures you want to use, you can change 
their positions in the job. To move a signature, select it in the 
Signature Selection dialog box, then click Move Up or Move Down. 
To delete a signature, select it, then click Delete.

5. When you have finished adding signatures to the job, click OK. The 
signatures appear in the Signature List window.

Saving and Naming a Job

1. From the File menu, choose Save Job or Save Job As.

2. Type a name for the job and select the location where you want to save 
it.

3. Click Save.

Once you have saved and named a Preps job:

• It can be stored anywhere on the system.

• It is portable between Macintosh and Windows versions of Preps.

• It contains references to all source files used, rather than embedding 
the files in the job.



Activity 1: Building a Job 11

Scenario

The customer has supplied PostScript files for an 8.5" x 11" (A4), 76-page, 
saddle-stitched book. There is a separate file for each chapter. When the 
files were created, blank pages were not included, so the total page count is 
incorrect and many of the chapters do not start on odd-numbered, or 
right-hand pages.

1. From the File menu, choose New Job, then Mixed Files -> PostScript.

2. From the Learning Preps:Activity Files:Art of Imagery:PS:US (Metric) 
folder, add the following files to the file list:

• Appendix.sep (Appendix_A4.sep)

• BackCover.sep (BackCover_A4.sep)

• Chapter1_11pg.sep (Chapter1_11pg_A4.sep)

• Chapter2_12pg.sep (Chapter2_12pg_A4.sep)

• Chapter3_15pg.sep (Chapter3_15pg_A4.sep)

• Chapter4_19pg.sep (Chapter4_19pg_A4.sep)

• Cover.sep (Cover_A4.sep)

• Frontmatter.sep (Frontmatter_A4.sep)

Activity

Activity 1: Building a Job
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3. De-select the Add all pages to run list check box.

4. Click Done.

5. Click on the file in the file list, and drag the files individually to the 
run list in the following order:

• Cover.sep (Cover_A4.sep)

• Frontmatter.sep (Frontmatter_A4.sep)

• Chapter1_11pg.sep (Chapter1_11pg_A4.sep)

• Chapter2_12pg.sep (Chapter2_12pg_A4.sep)

• Chapter3_15pg.sep (Chapter3_15pg_A4.sep)

• Chapter4_19pg.sep (Chapter4_19pg_A4.sep)

• Appendix.sep (Appendix_A4.sep)

• BackCover.sep (BackCover_A4.sep)
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6. Examine the first page of each chapter in the run list. Each chapter or 
section should start with an odd-numbered page. Add blank pages to 
the run list as needed. Remember, the total page count must be a 
multiple of 4, and the BackCover should be an even-numbered page.

Next you add signatures to the signature list. The template created for 
this job is in the Sample Templates:US (Metric) folder and is called 
Letter Tutorial Saddle (A4 Tutorial Saddle).

7. The signatures required for this job are: 4 16 page SW, 1 8 page WT, 
and 1 4 page wt. To manually add the signatures in the order listed 
below, select the signature and click Add. The correct order for the 
signatures is:

16 page SW

8 page WT

16 page SW

16 page SW

16 page SW

4 page wt

8. Once you’ve added the above signatures, click OK to close the 
Signature Selection window.

9. Save the job as <yourname>Job1.

Check Your Work
Compare the finished job to the following 3 diagrams.
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Note:  There should be a total of 76 pages in the run list. There should be 1 blank 
page inserted before page 1 of the Frontmatter, page 1 of Chapter 1, page 1 
of Chapter 2, (Chapter 3 starts on an odd-numbered page so no blank is 
needed), page 1 of Chapter 4, page 1 of the Appendix, and 2 blank pages 
inserted before the BackCover.
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Module Wrap-Up
In this module, you learned to:

• Create a basic Preps job

• Add source files to the file list

• Add pages to the run list

• Modify the file list and run list

• Add signatures to a job

• Save and name a job
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Module Objectives
By the end of this module, you will be able to:

• Add a placeholder to a Preps job

• Edit a placeholder

• Replace a placeholder with a source file

• Split a placeholder

• Convert a source file to a placeholder

• Use placeholders in a job
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Using Placeholders in a Preps Job

Overview
Placeholders are used to set up a job before all the source files are available. 
When you add a placeholder, you give it a name and page count, then add 
it to the file list and run list. You replace the placeholder when the source 
file becomes available.

Adding a Placeholder to a Preps Job

1. Drag and drop the placeholder into the file list.

Or:

From the Job menu, choose Add Placeholder. The Add Placeholder 
dialog box appears.

2. In the Name box, type a name. If you do not know the exact name of 
the source file, type any descriptive name or use the default name 
Placeholder 1.

3. In the Page count box, type the number of pages in the file.

4. To add the pages to the run list automatically, select the Add all pages 
to run list check box.

5. Click OK.
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Editing a Placeholder
You can change the name of the placeholder or the page count at any time.

1. From the file list, select the Placeholder icon.

2. From the Edit menu, choose Get Information.

3. The Placeholder Information dialog box opens. Type the changes, 
then click OK.

Replacing a Placeholder With a Source File
When the source file becomes available, you replace the placeholder.

1. From the file list, select the placeholder.

2. From the Job menu, choose Replace Placeholder.

3. Navigate to the source file, select it, then click Choose.

Different Page Count in Placeholders and Source Files
If the source file contains more pages than you indicated for the page count 
of the placeholder, a warning message appears offering three options:

• Adding the extra pages to the run list after the last page of the 
placeholder

• Not adding the extra pages to the run list

• Canceling the replacement of the placeholder

If the source file contains fewer pages than you indicated for the page count 
of the placeholder, a warning message appears offering three options:

• Removing the extra pages from the run list

• Splitting the placeholder, which creates a new placeholder for the 
missing pages

• Canceling the replacement of the placeholder
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Splitting a Placeholder

1. From the file list, select the placeholder.

2. From the Job menu, choose Split Placeholder.

3. The Split Placeholder dialog box appears. In the First placeholder box, 
type the number of pages for the first placeholder. The second 
placeholder contains the remaining pages.

4. Click OK.

Converting a Source File to a Placeholder
If a source file used in a job is incorrect, you can convert it to a placeholder 
to be replaced with a new source file at a later time.

1. From the file list, select the source file.

2. From the Job menu, choose Convert To Placeholder.
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Scenario

A customer job arrives that requires a tight production schedule. Not all of 
the source files are available, but there are enough to begin printing a 
couple of signatures. You use placeholders to set up the job and begin 
printing; when the rest of the source files are available, you complete the 
job.

1. From the File menu, choose New Job, Mixed Files -> PostScript.

2. Drag the Placeholder icon to the run list. The Add Placeholder dialog 
box appears. In the Name box, type Brochure. In the Page count box, 
type 24. Select the Add all pages to run list check box, then click OK.

3. In the Signature List window, click Signatures.

4. From the Binding Style list, select Saddle-Stitched. The template 
created for this job is in the Sample Templates:US (Metric) folder and 
is called Letter Tutorial Saddle (A4 Tutorial Saddle).

Activity

Activity 1: Using Placeholders in a Job
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5. Select the Letter Tutorial Saddle (A4 Tutorial Saddle) template, and 
click Auto Select. You should see 2 signatures in the list; one 16-page 
Sheetwise, and one 8-page Work and Turn.

6. Click OK.
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The customer calls regarding the job. He explains that instead of one 24-
page PostScript file, you will receive a 16-page file called Brochure.ps and 
an 8-page file called Insert.ps. You can split the placeholder into two 
separate placeholders.

From the file list, select the placeholder. From the Job menu, choose 
Split Placeholder. In the First placeholder box, type 16 for the page 
count. Note that the page count for the second placeholder is 
automatically calculated. Click OK. There are now two placeholders in 
the file list.

The PostScript files arrive from the customer. You now replace the 
placeholders.

1. From the file list, select the 16-page placeholder. From the Job menu, 
choose Replace Placeholder. Navigate to the Learning Preps:Activity 
Files:Brochure:US (Metric) folder and select Brochure.ps (Brochure-
A4.ps). Click Choose. The placeholder is replaced with the PostScript 
file.

2. Select the 8-page placeholder. From the Job menu, choose Replace 
Placeholder. Navigate to the Learning Preps:Activity Files:Brochure:US 
(Metric) folder and select Insert.ps (Insert-A4ps). Click Choose. The 
placeholder is replaced with the PostScript file.
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The customer makes changes to the brochure and calls to explain that a 
new PostScript file is coming.

Select the Brochure.ps icon in the file list. From the Job menu, choose 
Convert to Placeholder.

The new PostScript file arrives, but the customer has made a single file that 
includes both the brochure and the insert.

1. Select the Insert.ps icon in the file list. Press the Delete key. A dialog 
box appears asking, Remove this file from the File List, and remove its 
pages from the Run List? Click Yes.

2. Select the Brochure.ps (Brochure-A4.ps) placeholder in the file list. 
From the Job menu, choose Replace Placeholder. Navigate to the 
Learning Preps:Activity Files:Brochure:US (Metric) folder and select 
Brochure_with_Insert.ps (Brochure_with_Insert A4.ps). A dialog 
appears informing you the page count of the placeholder is smaller 
than the PostScript file, and asks if you want to continue. Click Yes.

The job is now ready to save and print.
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Module Wrap-Up
In this module, you learned to:

• Add a placeholder to a Preps job

• Edit a placeholder

• Replace a placeholder with a source file

• Split a placeholder

• Convert a source file to a placeholder

• Use placeholders in a job
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Module Objectives
By the end of this module, you will be able to:

• Add and remove an output device

• Configure an output device

• Create a custom page size

• Specify preferences for measurement units, language, input file 
handling, output options, folder locations, and PDF handling
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Configuring Devices

Overview
Preps supports any output device for which a PostScript Printer 
Description (PPD) file is available. PPD files contain information about 
the output device, such as available page sizes, recommended resolutions, 
halftone line screens, halftone spot shapes, screen angles, and built-in 
fonts.

Preps ships with a number of PPD files that were originally provided by the 
output device manufacturers, but only a few are included when you install 
Preps. Additional PPD files are available on the Preps CD in the PPD Files 
folder, but they may be outdated, so we recommend that you use the PPD 
file that was supplied with the output device or that you generated using a 
RIP utility.

You add PPD files to Preps by copying them into the Preps 5.0:printers:ppd 
folder. The name must end in “.ppd” and cannot contain any special 
characters such as ampersands, slashes, and so on.

When you install Preps for the first time, you must add, configure, and 
connect the output devices you want to use. You may add as many output 
devices as required at any time.
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Adding and Removing a Device
When you add a device, give it a unique nickname. Because each instance 
of a device is uniquely named, you can add the same device multiple times. 
This allows you to save different configuration options for an output 
device. 

Adding a Device

1. From the Setup menu, choose Device Setup.

2. Click Add Device.

3. From the Device Type list, select the device. The names in this list are 
taken from the Model Name inside the PPD file and are usually 
different from the file name you see in the Finder or Explorer.

4. In the Nickname box, type a descriptive name for the device.

5. Click OK. The Device Configuration dialog box appears.

Removing a Device

In the Device Setup dialog box, select the device, then click Remove 
Device.
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Device Configuration
Output device options that you can configure include the page size, 
alignment, resolution, line screen, halftone spot shape, and screen angle. 
The information that appears in the Device Configuration dialog box is 
taken from the PPD or PPX (PPD extension files used by Preps for some 
output devices) for the device. You can change the configuration of an 
output device at any time.

Alignment
Changing the numbers in the Horizontal and Vertical boxes under 
Alignment moves the imaged data within the imageable area defined by 
the page size. Do not use alignment adjustments in conjunction with 
punch coordinates because they conflict.

Punch Coordinates
If the output device has a center punch, the horizontal and vertical 
coordinates for the selected page size, appear in the Punch Coordinates 
area of the Device Configuration dialog box. The numbers that appear 
here indicate the position of the punch mark relative to the PostScript 
origin point. If punch coordinates are not specified for the selected page 
size, this area of the dialog box is blank.
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OPI Images As
If the job contains OPI-linked TIFF images and Preps Pro or Preps XL is 
doing the image replacement, you can print composite output on a color 
output device as either Color or Grayscale. The type of output is generally 
decided on a per-job basis. Printing grayscale composite output on a color 
output device is useful for quickly proofing a job.

Page Size
The Page Size list contains the page sizes that are supported by the output 
device. PPD files contain a limited number of pre-defined page sizes, but if 
the output device supports custom page sizes, you can add more page sizes 
to the list.

See Custom Page Size in the Preps 5.0 User Guide for information on creating 
custom page sizes.

Resolution
The Resolution list contains all the resolutions supported by the selected 
output device.

Line Screen
The manufacturer-recommended screen angles for the selected output 
device appear in the Line Screen list, but you can specify other line screen 
amounts by typing them in the box. The lines-per-inch (lpi) amount sets 
the line screen for halftones and composite (unseparated) output. 

The line screen amount is used in conjunction with the Override line 
screen option in the Print dialog box. See Module 9, Printing, Halftone 
Screening on page 154. The line screen amount specified here is used as the 
default line screen amount for spot colors, unless it is overridden by 
information in the PPD or on the RIP or output device.

Halftone Spot Shape
The halftone spot shapes that are supported by the selected output device 
appear in the Halftone spot shape list. The halftone spot shape is used in 
conjunction with the Override spot shape option in the Print dialog box. 
See Module 9, Printing, Halftone Screening on page 154. The halftone spot 
shape you select here is used when printing composite output. You select 
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the spot shape for separated output on the Color Separations tab of the 
Print dialog box. See Module 9, Printing, Line Screen and Screen Angle on 
page 157.

Screen Angle
The manufacturer-recommended screen angle for the selected output 
device appears in the Screen angle box. This number is used for composite 
output and for spot colors, unless it is overridden by the information in the 
PPD or on the RIP or output device. 

Connection

Macintosh

In Preps 5.0, all communication with output devices goes through CUPS 
(Common UNIX® Printing System) to be compatible with Mac OS X, 
which is based on UNIX. Using CUPS, Mac OS X can locate printers 
anywhere on your AppleTalk network using the OS 9-compatible PAP 
(Printer Access Protocol), or anywhere on the Internet using IP printing. 

In Preps 5.0, before you can add an output device to Preps, you need to add 
the printer using the Macintosh Printer Setup Utility, which is available 
from Go>Utilities.

Note:  Preps on Macintosh OS 9.2.2 and earlier does not use the Chooser. 
Instead, you establish the connection from within Preps. In the AppleTalk Zones 
area, select the zone, then, in the Select a Printer area, select the output device.
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In the Connection dialog box, from the Print Center list, select the 
appropriate device.

Windows

On Windows, in the Connection dialog box, select the Windows 
printer.
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Test Print
To produce output, a connection between Preps and the currently selected 
output device must be established. You can confirm the connection by 
clicking Test Print. This sends a small PostScript file that contains box with 
an X.

Fonts
When you click Fonts in the Device Configuration dialog box, the Device 
Fonts dialog box appears. This dialog box lists the fonts that are described 
in the PPD for the currently selected output device. If you downloaded 
fonts to the RIP that do not appear in this list, you can add the fonts to the 
list.

1. In the Font Name box, type the name of the font.

2. Click Add Font.

3. Click OK.
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Media
If the output device is a fixed-sheet device, such as a laser printer, you can 
specify the input and output trays.

1. Click Media.

2. In the Fixed Sheet Device dialog box, select the Input Tray and, if 
available, the Output Tray. Not all fixed-sheet devices have output 
trays.

3. Click OK.

Punch
Punch coordinates are used to precisely position the selected page size on 
the output media (film or plate) when printing from Preps. Some pre-
defined page sizes include punch coordinates. For those that do not, and 
for any custom page sizes you create, you can add punch coordinates. Even 
if the output device does not have a punch, you can use punch coordinates 
to precisely position the Preps output.

For instructions on configuring punch coordinates, see the Preps 5.0 User Guide.
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Job Log
The job log is a series of status messages the output device generates while 
Preps prints a job. You cannot print the Job Log from Preps; however, you 
can open and print it using a text editor. The Job Log file is called log.txt 
and is located in the Preps 5.0:Printers:(device nickname) folder.

Level 2 Options

Enable PostScript Level 2 color separations

Some PostScript Level 2 RIPs can do color separation. Preps allows you to 
take advantage of in-RIP separation while still retaining control over many 
separation settings, such as color builds and remapping of spot colors. 
When color separation in the RIP is enabled, Preps outputs a composite 
file instead of an individual file for each color. See Module 9, Printing, Level 
2 Options on page 158 for more information.

Use PostScript Level 2 forms optimization

For jobs using step and repeat, forms optimization creates smaller 
PostScript files that process faster. Forms optimization applies only to EPS 
files and composite color input and output.

Without forms optimization, if you re-use or step and repeat an image 10 
times, Preps sends the image 10 times. With forms optimization, Preps 
sends the image once and refers to it 10 times, reducing the processing time 
and the size of the PostScript file. Preps achieves this reduction by defining 
a Level 2 form for the image and using the form each time the image 
appears in the job.
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When you enable forms optimization, default amounts of image cache are 
already reserved for the selected output device. Creo recommends that you 
leave the default settings unchanged. However, if you are an advanced user 
of Preps and are sure that the default settings are too low for forms 
optimization in a particular situation, you may want to change the settings

Custom Page Size
For output devices that support custom page sizes, the Custom Page Size 
option allows you to add and edit additional page sizes.

Adding a Custom Page Size

1. In the Device Configuration dialog box, click Custom Size. The Page 
Sizes dialog box appears.

2. Click Add.

3. In the Custom Page Size dialog box, type a descriptive name in the 
Page size box. The custom page size name cannot contain spaces or 
special characters.

4. In the Width and Height boxes, type the dimensions for the new page 
size.

5. The Orientation determines the orientation of the page size on the 
output media (film or plate). To ensure the orientation is correct, you 
must print a mock-up of a press sheet that fits on the custom page size 
in only one direction. See Module 9, Printing, on page 145. We 
recommend that you start with orientation 0. Each of the orientations 
in the list represents a 90-degree rotation.

6. Click OK.
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Editing or Deleting Custom Page Sizes

In the Page Sizes dialog box, select the page size, then click Edit or 
Delete.

PPD Information
After you edit the PPD settings for an output device in PPD Browser, the 
next time you open the Device Configuration dialog box for that device, 
PPD Information is available. The PPD Information window shows only 
the settings you have changed from the defaults. To change a setting shown 
in the PPD Information window, use the PPD Browser.

Preferences

Overview
You access the Preps preferences from the Preps menu. The changes you 
make to the preferences affect the general settings of the Preps application. 
In the Preferences dialog box, you select options for:

• General settings, such as workflow, measurement units, input file 
handling, and output options

• Folder locations

• PDF handling

• Font processing

See the Preps 5.0 User Guide for information on changing settings in the 
PPD Browser.
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General Tab

Default Workflow
The default workflow is the workflow that is selected when you create a 
new job using the keyboard shortcut (COMMAND+N on Macintosh, or 
CTRL+N on Windows). The choices are:

• Mixed Files -> PostScript
Allows you to add multiple types of source files and print to a 
PostScript output device or PostScript file

• PDF -> PDF
Allows you to add only PDF files as source files and export PDF files
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Measurement Unit
The default measurement unit in Preps is decimal inches for the US 
English language, and millimeters for all other languages. You can select 
other measurement units to use as the default:

• Picas & Points
Expressed as 123p4 and based on the Adobe PostScript standard: 
1 inch = 72 points (1 mm = 2.835 points)

• Decimal Inches
Expressed as 12.345 in

• Centimeters
Expressed as 12.34 cm

• Millimeters

Expressed as 123.4 mm

• Points

Expressed as 1234pt

• Picas

Expressed as 123.45 pi

• Fractional Inches
Expressed as 12+3/4 in

Language
Preps comes with US English, Deutsch, Español, and Français.

In previous releases of Preps, you could switch between languages by 
selecting a language in the Preferences dialog box. In Preps 5.0 running on 
Mac OS X, you change languages at the operating system level, by moving 
the desired language to the top of the list in the International dialog box 
(Applications>System Preferences>International). You then restart Preps 
for the change to take effect.

Tip:  When you are working in Preps, you can type numbers using any 
measurement unit you want. Preps automatically converts them to the 
measurement unit set in the preferences.

Note:  On Windows, you use the Preferences dialog box to change languages, 
and the change takes place immediately, without restarting Preps.
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Input Options

Autoreverse Backward Page Order
Some source files are created with their pages in reverse numerical order. 
When the Autoreverse backward page order check box is selected, Preps 
changes the order of the pages whenever it encounters the tag that indicates 
descending page order. This option does not affect files that do not contain 
this tag.

Use Index Files (.PSI Files)
Index files are created after Preps reads the source files and contain only the 
information Preps needs to load the files. This is used when you reopen 
Preps jobs that contain large, unchanged source files. In these cases, Preps 
reads the index file rather than re-parsing the source file to find 
information such as the number and size of pages, colors, and fonts used in 
the file. If the source files are small, or if you do not often reopen Preps 
jobs, you should not use index files.

Report Modified Source Files
When this check box is selected and a source file has been changed since 
the last time the job was saved, Preps displays a message box indicating that 
changes to the source file may make it necessary to modify the job’s run list 
(for example, if the page count of the file has changed).

Ignore Bounding Box as Default
The bounding box may define the elements on a page, rather than the trim 
size of the page itself. If a job contains pages whose bounding boxes are 
different for each page, you will need to set up offsets for each page 
individually so they will be positioned correctly. If you select the Ignore 
bounding box by default check box, Preps ignores the bounding box and 
places all pages that are subsequently added to jobs in the same relative 
position to the PostScript 0,0 point. This 0,0 point is typically to the lower-
left corner of the page in the source document, someplace outside the page 
trim area. Ignoring the bounding box allows you to use a single set of 
offsets for all pages to position them correctly in Preps.



Preferences 45

Autocenter Run List Pages
Some source files are positioned incorrectly when you add them to a Preps 
job. For example, Rampage™ FPOs typically require page offsets of about 
half an inch. The Autocenter run list pages option automatically centers 
all pages that you add to the run list.

Add Pad Pages for Missing Pages
When you print selected pages from a source document to a PostScript or 
PDF file, the other pages in the document are omitted. When you add the 
file to a Preps job and the Add pad pages for missing pages check box is 
selected, Preps adds pad pages to replace the missing pages. This is useful 
when creating layering jobs (digital double burns).

Output Options

Display Punch Mark
The punch mark is used to accurately position Preps output on the selected 
page size (film or plate). If you do not want this mark to print, clear the 
Display punch mark check box. The punch mark is always displayed in the 
template editor.

Print Side Center Marks
Preps automatically places center marks at the top and bottom of the press 
sheet. To print center marks on the left and right sides of the press sheet, 
select the Print side center marks check box.

Ignore Split File Output Errors
When this option is selected and Preps is printing divided output, such as 
signatures or sides (see Module 9, Printing, on page 145), if a PostScript 
error occurs in one of the parts (signatures, sides, and so on) of the job, 
Preps provides the option to continue printing the subsequent parts. If the 
Ignore split file output errors check box is cleared, the remaining parts do 
not print.

Print Crop Marks for Bleed Bounds
When the Print crop marks for bleed bounds check box is selected, crop 
marks that indicate the page bleeds appear on the printed output. These 
bleed crop marks do not appear in the template editor.
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Image by Template Page Number
When the Image by template page number check box is selected, Preps 
images the pages in the order in which they appear on the template. This is 
necessary when using a layering template. The default setting for this check 
box to be cleared. This creates the smallest possible file size output by 
optimizing processing of the source files.

See the Preps User Guide for more information on layering.

Folders Tab

You can specify or change the location of several folders that Preps uses:

• Temporary files

• Templates and marks

• Output path

• Web growth compensation sets

Setting Up or Changing Folder Locations

1. Click Select for the folder location you want to modify.

2. Navigate to the location you want to use. If you want to create a new 
folder, click New Folder, type a name for the folder, then click Create.
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3. When you have selected the folder you want to use, click Choose.

Temporary Folder Location
On Macintosh, the temporary files that Preps creates are stored in the 
invisible Temporary Items folder. The operating system automatically 
empties this folder whenever the computer is shut down or restarted. 

On Windows, Preps uses the PrepsTemp folder that is stored within a 
single, system-wide temporary folder called Temp that cannot be changed.

Templates and Marks Folder
You can store templates in a central location, such as on a server, so they 
can be accessed from several workstations. The Templates and Marks 
folders must be located in the same parent folder. For example, the 
Templates folder cannot be located on a server with the Marks folder 
located on a local hard drive. When you select a parent folder as the 
location for templates and marks, subfolders called Templates and Marks 
are automatically created. The Marks folder also contains a subfolder called 
dupmarks. Move the templates and marks you want to use with Preps into 
their respective folders.

Output Path
Output Path is used to establish the default location for printing from 
Preps to a PostScript file.

Compensation Sets Path
The Compensation Sets Path is the location where you store the web 
growth compensation set for Preps Pro. If you are using multiple copies of 
Preps, you may want to store the compensation sets on a server that is 
accessible to all Preps workstations.
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PDF Tab

When working in a “mixed files” workflow, Preps creates PostScript files 
from all PDF source files. You can configure Preps to use an internal 
converter or Adobe Acrobat to perform this conversion. If you want to use 
Acrobat, you must install an Acrobat plug-in and select the location of 
Acrobat. 

Font Processing Tab
You configure font-processing options on the Font Processing tab of the 
preferences.

See the Preps 5.0 User Guide for more information on fonts.

See Module 10, Native PDF Workflow and the Preps 5.0 User Guide for more 
information on the PDF-in/PDF-out workflow.
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Module Wrap-Up
In this module, you learned to:

• Add and remove an output device

• Configure an output device

• Create a custom page size

• Specify preferences for measurement units, language, input file 
handling, output options, folder locations, and PDF handling
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Module Objectives
By the end of this module, you will be able to:

• Identify the basic parts of a template

• Create a new template

• Select a binding style

• Add a signature

• Select a work style

• Create an imposition

• Assign page numbering

• Adjust margins and gutters

• Save a template

• Add additional signatures

• Add independent pages to a press sheet

• Step and repeat independent pages
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Template Basics

Overview
Templates are the layout masters that are used in Preps jobs to produce 
imposed output that can be printed. The template provides a pattern, or 
framework, into which job pages flow and ensures that when the job is 
printed, the pages are imposed and positioned correctly.

Preps ships with a number of templates that contain commonly used 
layouts for different binding styles. It is easy to create custom templates 
that can be tailored to specific requirements.

Parts of a Template
Preps templates are based on specific binding styles and may contain:

• Press sheets

• Signatures

• Template pages

• Template marks

• Gutters

Basic Rules of a Template
• A template is not limited to a specific job

• A template can be used repeatedly, for multiple jobs, regardless of the 
number of pages in the job

Templates Are Based on
• Printing device/press

• Binding style

• Finished page trim size

• Work style
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Template Tool Palette
When a template is created or opened, Preps displays the Template Tool 
palette. These tools are used to view, create, and edit templates.

 

Select Object: Selects objects in the template editor

 Fit in Window: Fits the entire template in the window

 Show/Hide Pages: Shows or hides the pages on the imposition

 Zoom 2X (Macintosh only): Zooms in at 2X the current magnification

 Zoom: Marquee or click the template to zoom in

 Show/Hide Marks: Shows or hides the template marks

 Fit Press Sheet in Window: Fits the selected press sheet in the window

 Last View: Switches between the two most recent views

 Show/Hide Gutters: Shows or hides the gutters

 Page Numbering: Numbers the template pages

 Show/Hide Grid: Shows or hides the grid

 Show/Hide Tiles: Shows or hides the tiles

 Grabber (Windows only): Scrolls around the template

Mac Tool Palette Windows Tool Palette
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Template Menu
When you open or create a template, Preps adds a Template menu to the 
menu bar. The commands in the Template menu are used to add 
information to templates and adjust the way they appear on screen.

Creating a New Template
In a production environment, job specifications are frequently described 
on a job ticket. In Preps, you transfer those job specifications to a template.

To create a template, you need the following information:

• Binding style

• Press sheet size

• Finished page size (trim)

• Work style

• Folding dummy

• Setback amount (plate bend)

• Imposition layout
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Scenario

This activity teaches you how to create a saddle-stitched template that 
contains three signatures: a 16-page sheetwise, an 8-page work-and-turn, 
and a 4-page work-and-turn.

Creating a Template

1. From the File menu, choose New Template. 

2. Preps prompts you to name the template. Because all the signatures in 
a template must share the same binding style and page trim size, you 
could include these attributes in the name. In the Template Name box, 
type Letter Saddle-stitched (A4 Saddle-stitched).

Selecting a Binding Style
The binding style determines the order in which run list pages flow 
through the template. When you use the Auto Select feature, Preps flows 
the run list pages through the largest signature in the template. If there 
aren’t enough run list pages remaining to complete another full signature, 
and partial signatures exist in the template, Preps flows the remaining run 
list pages through the signature that most closely matches the number of 
remaining pages. If there are not enough pages to fill the last signature, the 
last template pages are left empty. 

There are five binding styles available in Preps. Flat work, perfect-bound, 
saddle-stitched, come ‘n go, and cut and stack. The Preps 5.0 Learning 
Guide focuses on the saddle-stitched, perfect-bound, and flat work binding 
styles. 

Activity

Activity 1: Creating a Saddle-Stitched Template



Activity 1: Creating a Saddle-Stitched Template 57

Flat Work
The flat-work binding style is used for unfolded signatures. Flat work does 
not have any binding. When a job uses a flat-work template, Preps flows 
the run list pages into the signature by matching the number of the run list 
page to the number of the template page.

Perfect Bound
When a job uses a perfect-bound template, Preps flows the run list pages 
through each signature in the order that the pages appear in the run list.

Saddle Stitched
When a job uses a saddle-stitched template, Preps flows equal numbers of 
pages from the beginning and from the end of the run list through each 
signature in the job. For example, in a saddle-stitched job using a 16-page 
signature, Preps flows the first 8 pages and the last 8 pages in the run list 
through the signature.

See the Preps User Guide for additional information on binding styles.

1. To select a binding style, in the New Template dialog box, from the 
Binding Style list, select Saddle-Stitched.

2. Click OK.



58  Module 4 – Templates

 

Adding a Signature
The Add Signature dialog box appears. This dialog box is where you type 
information about the first signature in the template.

1. In the Signature name box, type 16-page sheetwise.

2. Accept the default setting of Make Signature Available for Auto 
Select.

3. Accept the default setting of 1 for Number of sections. Multiple 
sections are available only in Preps Pro and are considered an 
advanced-user option, so they are not covered in the Preps 5.0 
Learning Guide. 

See the Preps User Guide for information on multiple sections.



Activity 1: Creating a Saddle-Stitched Template 59

Selecting a Work Style
There are five work styles available in Preps. Sheetwise, work-and-turn, 
work-and-tumble, perfector, and single-sided. The work style you select 
depends on how the job will be run on the press. 

The Preps 5.0 Learning Guide focuses only on the sheetwise, work-and-
turn, and single-sided work styles. 

See the Preps User Guide for additional information on work styles.

Sheetwise
Sheetwise uses different plates to print the front and the back of the press 
sheet. The paper is run through a press that prints on one side of the sheet. 
The first plate is used to print the front side of the press sheet. The paper is 
then turned over along the vertical axis and run through the press again, 
using the second plate to print the back side of the press sheet.

Work-and-Turn
The work-and-turn work style contains both sides of the imposition on the 
same plate. Work-and-turn jobs are created to use the same gripper edge 
and the opposite side guide for positioning the back and side guides of the 
press sheet. After the first side is printed, the press sheet is turned over 
from left to right so the second side can be printed. After printing, the sheet 
is cut in half along the vertical axis, resulting in two separate, identical 
signatures.

Single-Sided
The single-sided work style prints the press sheet only on the front side. 
This work style is often used for posters and other single-sided jobs.

1. Under Press Sheet, from the Work style list, select Sheetwise. 

2. The first signature you create has a press sheet size of 38" x 25" (1000 
mm x 700 mm). These dimensions appear in the Width and Height 
boxes as the defaults.

Note:  Preps always places the gripper edge of the press sheet at the bottom of 
the computer screen.
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3. Leave the Position of side guides, From, and Length of center marks 
settings at the defaults.

4. The “setback” or “plate bend” amounts are described in the Press 
sheet edge to punch center box. This amount depends on the press 
on which the job is to be printed. Accept the default of 0.

5. Click OK.

The first signature appears on the computer screen. A solid line 
encompasses the signature, and a solid line defines each side of the press 
sheet.

Note:  When you add elements to a press sheet, you work only on the front side. 
Preps automatically mirrors all elements on the back side.

Creating an Imposition

1. From the Template menu, choose Create Imposition.

2. Under Finished Page Size, accept the default amounts in the Width 
and Height boxes of 8.5 in x 11 in (210 mm x 297 mm [A4]).

3. Under Number of Imposed Pages, type 4 in the Horizontal box, and 
type 2 in the Vertical box. This describes an imposition that has, on 
the front side of the press sheet, two rows of 8.5" x 11" (210 mm x 297 
mm [A4]) pages with four pages in each row.

4. In the Length of Fold Mark box, accept the default amount of 0.5 in (6 
mm).
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5. Under Page Orientation, in the Lower left page’s head faces list, 
select Up. 

6. From the Layout additional pages list, select Head to Head.

7. Under Placement on Press Sheet, leave the Center horizontally option 
selected.

8. Click the Fixed bottom margin option, and type 0.875 in (25 mm).

Note:  If the Measurement unit in the Preferences dialog box is Fractional 
Inches or Decimal Inches, you do not need to type in after the amounts.

9. Click OK.

The press sheet now has an imposition on it that shows pages, margins, 
and gutters. The margins and gutters are the shaded areas between and 
around the pages.
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Page Numbering
The numbering sequence on the template pages determines the order in 
which the run list pages flow through the template when it is used in a job. 
Each signature in a template starts with the number 1. For example, a 16-
page signature is numbered 1-16, and an 8-page signature in the same 
template is numbered 1-8.

1. Select the Numbering tool from the Tool palette.

2. Place the cursor over the page in the upper-left corner of the front side 
of the press sheet and click once. Note that the Numbering tool in the 
Tool palette now displays the number 4.

3. Place the cursor over the page in the upper-right corner of the front 
side of the press sheet and click once. Note that the number on the 
back side of the press sheet change automatically.

4. The Numbering tool in the Tool palette now displays the number 5. 
Follow the numbering pattern in the following diagram to finish 
numbering the pages on the front side of the press sheet.

5. If you make a mistake in the numbering sequence, double-click the 
Numbering tool. The Page Number dialog box appears. Type the 
correct number in the Current page number box, then click OK. 
Notice that the number in the Numbering tool on the Tool palette 
changes.
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Template Page Information
The Template Page Information dialog box allows you to change page 
numbers, the orientation of a page, as well as view the page size and 
position.

1. Click a page on the template to select it.

2. From the Edit menu, choose Get Information.

3. Do not modify the template page information at this time. Click 
Cancel to close the Template Page Information dialog box.

Adjusting Margins and Gutters
The margins are the areas between the edges of the press sheet and the 
imposition. The gutters are the area between the rows of imposed pages. 
You define only the left and bottom margin values. The right and top 
margins default to the remaining available space. You can adjust the left 
and bottom margins in the Create Imposition or Modify Imposition dialog 
box by selecting the Fixed left margin or Fixed bottom margin option.

Adjusting Gutters

1. Select the Select Object tool from the Tool palette. 

2. Click the vertical gutter between pages 1 and 16.

Tip:  To use the “repeat page number” option for numbering multiple pages 
with the same number, hold down the SHIFT key as you click with the 
Numbering tool.
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3. When the gutter is selected, from the Edit menu, choose Get 
Information.

4. In the Left Half and Right Half boxes, type 0.

5. Click OK.

6. Click the vertical gutter between pages 4 and 13, then repeat steps 3 
through 5.

7. Click the vertical gutter between pages 13 and 16, then from the Edit 
menu, choose Get Information.

8. In the Left Half and Right Half boxes, type 1.125 in (25 mm).

9. Click OK.

Verifying the Left and Right Margins

1. Click the left vertical margin, then from the Edit menu, choose Get 
Information. 0.875 in (55 mm) should appear in the Left Margin box. 
If this is incorrect, from the Template menu, choose Modify 
Imposition. Select the Fixed left margin option and enter the correct 
value.

2. Click OK.
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3. Click the right vertical margin, then from the Edit menu, choose Get 
Information. 0.875 in (55 mm) should appear in the Right Margin 
box. Notice that you cannot change this number. Click OK or Cancel. 
If the Right Margin amount is incorrect, go back and check the 
amounts for the vertical gutters.

Setting the Horizontal Gutters

1. Click the horizontal gutter between the heads of the pages, then from 
the Edit menu, choose Get Information.

2. In the Top Half and Bottom Half boxes, type 0.25 in (6 mm), then click 
OK.

3. Click the horizontal margin at the bottom of the press sheet. From the 
Edit menu, choose Get Information, and verify that it says 0.875 in (25 
mm). If this number is incorrect, change it. Click OK.

4. Click the horizontal gutter at the top of the press sheet. From the Edit 
menu, choose Get Information, and verify that it says 1.625 in 
(69 mm). If this is incorrect, go back and check the amount for the 
horizontal gutter.

Saving a Template
It is a good idea to save a template after you create each signature. You can 
save a template in any location, such as in a customer job folder, but you 
cannot use it in a Preps job unless it is in the Templates folder. 

Tip:  The only way to select a gutter that has a width of 0 is to drag a marquee 
around the gutter, starting completely off one edge of the press sheet and 
dragging off the opposite edge of the press sheet.

Tip:  You can create subfolders within the Templates folder. For example, you 
may want to group your templates based on the press for which they were 
created.
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1. From the File menu, choose Save Template As.

2. The default name for the template is the name you typed when you 
first created the template, but you can type a different name in the 
Save As box if you want.

3. Click Save.

The template you created contains a 16-page signature that can be used 
with any 8.5" x 11" (A4) saddle-stitched job.
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Scenario

Not all jobs have page counts in 16-page increments. But if a template 
contains a 16-page signature, an 8-page signature, and a 4-page signature, 
you can impose almost any job regardless of the number of pages.

Adding a 4-Page Work-and-Turn Signature

1. Using the same template from Activity 1, “Creating a Saddle-Stitched 
Template,” from the Template menu, choose Add Signature.

2. In the Signature Name box, type 4-page Work/Turn 19x25 
(455 mm x 650mm). Leave Number of sections and Make signature 
available for auto select at the default settings.

3. Under Press Sheet, from the Work style list, select Work and Turn.

4. In the Width box, type 25 in (650 mm).

5. In the Height box, type 19 in (455 mm).

Activity

Activity 2: Adding Additional Signatures
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6. Leave all other options at the default settings. Click OK.

There is now a new signature that does not contain an imposition. Notice 
that this press sheet appears to have only one side. There is a vertical line in 
the center of the sheet. The left half of the press sheet represents the front 
side of the work-and-turn signature, and the right half of the sheet 
represents the back side.

Creating an Imposition

1. From the Template menu, choose Create Imposition.

2. Under Finished Page Size, in the Width and Height boxes, accept the 
default amounts of 8.5 in x 11 in (210 mm x 297 mm).

3. Under Number of Imposed Pages, type 1 in the Horizontal box, and 
type 2 in the Vertical box.

4. In the Length of Fold Mark box, accept the default amount of 0.5 in 
(6 mm).

5. Under Page Orientation, from the Lower left page’s head faces list, 
select Right.

6. From the Layout additional pages list, select Head To Head.

Note:  On a work-and-turn signature, the front side is represented by the left 
half of the press sheet, so even though there is a total of eight pages on the 
press sheet, the front side contains two rows of two pages.
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7. Under Placement on Press Sheet, click the Fixed left margin option, 
and type 1.25 in (20 mm).

8. Click the Fixed bottom margin option, and type 0.875 in (15 mm).

9. Click OK.

10. The only gutter that needs to be defined is the horizontal gutter 
between the pages. Select this gutter, then, from the Edit menu, choose 
Get Information.

11. In the Top Half and Bottom Half boxes, type 0.

12. Click OK.

13. Select the Numbering tool in the Tool palette, and number the pages to 
match the following diagram.



70  Module 4 – Templates

 

Adding a 8-Page Work-and-Turn Signature
Now create an 8-page work-and-turn signature.

1. Add a new signature with a press sheet size of 38" x 25" (1000 mm x 
700 mm).

2. Create an imposition with 8.5" x 11" (210 mm x 297 mm [A4]) pages, 
placed 2 horizontally and 2 vertically. The lower left pages head faces 
up, and the additional pages are placed head to head.

3. Set the left margin to 0.875" (25 mm), and the bottom margin to 
0.875" (25 mm).

4. Change the gutters to a width of 0 as illustrated in the above diagram.

5. Number the pages following the diagram above.
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Scenario

You can create layouts that contain pages that have different sizes and 
orientations, which can be used for flat work or ganged jobs. You do this by 
using independent pages, which are added to the press sheet one at a time 
and do not have gutters. Individual independent pages can be deleted or 
moved, or even overlapped on top of other pages.

Adding Independent Pages

1. Create a new perfect bound template, and name it Independent Pages.

2. Add a signature using a sheetwise work style, and a press sheet with a 
width of 38" and a height of 25" (1000 mm x 700 mm).

3. From the Template menu, choose Add Independent Page.

4. Under Page Number, accept the default page numbers in the Front 
and Back boxes (1 and 2).

Activity

Activity 3: Creating a Signature Using Independent 
Pages
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5. Under Finished Page Size, accept the default amounts in the Width 
and Height boxes of 8.5 in and 11 in (210 mm x 297 mm [A4]).

6. Under Lower Left Corner of Page, you type the position of the lower-
left corner of the independent page relative to the lower-left corner of 
the press sheet. In the Horizontal box, type 1 in (25 mm), and in the 
Vertical box type 3 in (50 mm).

7. From the Page Orientation list, accept the default head direction of 
Up.

8. Click OK.

The independent page appears on the press sheet. You can reposition 
independent pages by clicking and dragging them to a new location on the 
press sheet.

Step and Repeat
You use the step-and-repeat feature to duplicate an independent page on a 
press sheet. Step-and-repeat is used for jobs such as multiple business cards 
on a press sheet.

1. Using the same template, from the Template menu, choose Add 
Signature. The Add Signature dialog box appears.

2. In the Signature name box, type Business Cards.

3. From the Work style list, select Single-Sided.

4. Accept the default press sheet size of 38" x 25" (1000 mm x 700 mm).

5. Click OK.

6. From the Template menu, choose Add Independent Page.
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7. Under Page Number, in the Front box accept the default page number 
of 1.

8. Under Finished Page Size in the Width box, type 3.5 in (100 mm). In 
the Height box, type 2 in (50 mm).

9. Under Lower Left Corner of Page in the Horizontal and Vertical 
boxes, type 1.5 in (27.5 mm).

10. From the Page orientation list, accept the default head direction of 
Up.

11. Click OK.

12. Click the independent page to select it.

13. From the Edit menu, choose Step and Repeat.

14. Under Total Number in the Horizontal box, type 10 (in metric, type 9). 
In the Vertical box type 11 (in metric, type 11). This results in a total 
number of pages on the press sheet of 110: 11 rows with 10 pages in 
each row. (In metric, 99: 11 rows with 9 pages in each row.) The total 
number includes the original page.
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15. Under Displacement Offset, in the Horizontal box type 3.5 in
(105 mm). In the Vertical box type 2 in (55 mm). The amount includes 
the size of the independent page and any amount you want the pages 
to be offset.

16. Click OK.

Nesting and Layering
You can overlap independent pages to fit images together to maximize the 
space on the press sheet and to avoid media waste. This technique is called 
nesting.

Independent pages can be layered, or placed directly on top of other pages, 
to create the digital equivalent of a double burn. The final output consists 
of a combination of two or more pages superimposed. This technique is 
called layering.

See the Preps 5.0 User Guide for more information on layering and nesting.
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Module Wrap-Up
In this module, you learned to:

• Identify the basic parts of a template

• Create a new template

• Select a binding style

• Add a signature

• Select a work style

• Create an imposition

• Assign page numbering

• Adjust margins and gutters

• Save a template

• Add additional signatures

• Add independent pages to a press sheet

• Step and repeat independent pages
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Module Objectives
By the end of this module, you will be able to:

• Identify the two types of template marks

• Identify where Preps stores marks

• Add a smart duplicating mark to a template

• Add a smart collation mark to a template

• Add a smart custom mark to a template

• Add a smart text mark to a template

• Save SmartMarks®

• Edit SmartMarks

• Specify SmartMark color

• Use a template containing SmartMarks in a job

• Create SmartMarks independent of a template

• Create a mark group

• Apply a mark group to a template
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Overview
Preps uses two kinds of template marks: 

• SmartMarks, which are positioned and sized dynamically and have 
special features

• Static marks, which are positioned by coordinates 

A variety of both kinds of marks are installed with Preps ready for use, and 
you can create your own custom EPS or TIFF marks for use as both 
SmartMarks and static marks. 

In Preps 5.0, you can create mark groups at the operating-system level or 
from within Preps. Only SmartMarks can be included in a mark group; 
static marks cannot be included.

Note:  Module 5, Marks focuses on the use of SmartMarks. 

See the Preps 5.0 User Guide for information on static marks.

Location of Template Marks
Template marks are stored in the Marks folder. For marks to be available 
for use with templates, the Marks folder must be in the same parent folder 
as the Templates folder. If you decide to move your templates to a different 
location, such as a server, Preps creates a new Templates folder, containing 
a new Marks folder, a new SmartMarks folder, and a new Dupmarks 
subfolder. Preps does not move your templates or marks for you; you 
manually move your templates, static marks, SmartMarks, and duplicating 
marks into their new folders, and delete the old, empty folders.

Preps Migration Utility
The Preps Migration utility enables you to easily copy output devices, 
marks, templates, and profiles from one installation of Preps to another. 
The Preps Migration Utility for Preps 3.5 and later runs on Mac OS® and 
Microsoft® Windows® operating systems.

For more information on the Preps Migration Utility, see the Preps installation CD 
and/or the technical bulletin Preps Migration Utility 1.x User Guide, available on 
the Creo web site.



80  Module 5 – Marks

 

SmartMarks Overview
SmartMarks are more powerful than static marks in their ability to 
reposition and resize themselves dynamically in response to rules you 
specify, and in their ability to be easily copied from template to template. 
SmartMarks are either embedded in a template or defined as a separate 
SmartMark file, known as a .SMK file. Many, but not all, SMK files contain 
a reference to an EPS or TIFF file in the Marks folder. The SMK file resides 
in the SmartMarks folder and contains the rules for placing the 
SmartMark; the referenced EPS file is imaged on the output media. You 
can specify SmartMark positions with respect to press sheets, impositions 
(with or without accounting for bleeds), vertical gutters, horizontal 
gutters, non-tiled media size, and the margins between an imposition and 
the edge of the press sheet.

Types of SmartMarks
The following types of SmartMarks are available in Preps:

• Rectangle marks

• Line marks

• Text marks

• Duplicating marks

• Collation marks

• Fold marks

• Crop marks

• Custom marks

Note:  The Module 5, Marks activities focus on the following SmartMarks; 
duplicating marks, collation marks, custom marks, text marks, and crop marks. 

Note:  Templates that contain SmartMarks are not backward-compatible with 
earlier versions of Preps. A SmartMark can not be converted to a static mark, and 
a template that contains SmartMarks is not compatible with Preps 4.x; however, 
older templates edited in Preps 5.0 that do not contain SmartMarks are still 
usable in Preps 4.x.

See the Preps 5.0 User Guide for information on smart rectangle marks, smart 
line marks, and smart fold marks.
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Scenario

In this activity you learn how to add a color bar to a press sheet. Although 
this activity focuses on duplicating marks, many of the SmartMarks have 
identical options and may also be covered.

Smart Duplicating Marks Overview
When you use a duplicating mark, the mark fills the area you specify, and 
any part of a mark that extends beyond that area is cropped.

The .SMK file for a smart duplicating mark is stored in the SmartMarks 
folder, and it references an EPS, TIFF, or PDF mark file in the Dupmarks 
folder. Smart duplicating marks can be rotated by 90, 180, or 270 degrees. 
You can set the size of the mark as fixed height and width; fixed height, and 
centered horizontally; or fixed height and centered vertically.

Creating a New Template

1. From the File menu, choose New Template. 

2. In the New Template dialog box, in the Template Name box, type 
SmartMarks.

3. From the Binding Style list, select Perfect Bound.

4. Click OK.

The Add Signature dialog box appears. 

5. In the Signature name box, type 16-page Sheetwise.

6. Accept the default setting of 1 for Number of Sections.

7. Accept the default setting of Make Signature Available for Auto 
Select.

8. Under Press Sheet, from the Work Style list, select Sheetwise. 

Activity

Activity 1: Adding a Smart Duplicating Mark
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9. In the Width and Height box, accept the defaults of 38 in x 25 in (1000 
mm x 700 mm [A4]). 

10. Accept the remaining defaults, and click OK.

Creating an Imposition

1. From the Template menu, choose Create Imposition.

2. Under Finished Page Size, accept the default amounts in the Width 
and Height boxes.

3. Under Number of Imposed Pages, type 4 in the Horizontal box, and 
type 2 in the Vertical box. 

4. Under Page Orientation, accept the default settings of Lower Left 
Page’s Head Faces: Up and Layout Additional Pages: Head To Head.

5. Under Placement on Press Sheet, accept the default placement of 
Centered horizontally and Centered vertically.

6. In the Length of fold mark box, accept the default amount.

7. Click OK.

8. The press sheet now has an imposition on it that shows pages, 
margins, and gutters.

9. Select the Numbering tool in the Tool palette, and number the pages to 
match the following diagram.
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Adding a Smart Duplicating Mark

1. From the Template menu, choose Add SmartMark>Dupmark.

2. In the Name box, type Activity 1 Colorbar.

A mark can be given a unique name for purposes of identification (for 
example, if the mark serves a specific purpose on the template, or is 
associated with a specific vendor or job).

Next you specify whether the mark is a fixed size, or has a variable height 
or width. You also specify the type of mark and whether it is rotated.

Table 1: Settings specific to smart duplicating marks

3. Select the Width is variable option.

4. In the Height box, type 0.25 in (6.35 mm).

5. From the Image file list, select colorbar.eps.

6. From the Image rotation list, accept the default of 0.

Setting Description

Fixed size box Places a mark that repeats itself as 
many times as possible filling the 
area specified in the Width and 
Height boxes.

Height is variable option Type an amount in the Width box 
to place a mark vertically that 
repeats itself as many times as 
possible based on the media size.

Width is variable option Type an amount in the Height box 
to place a mark horizontally that 
repeats itself as many times as 
possible based on the media size.

Image file list Select the image file to use in the 
mark.

Image rotation list Specify the amount by which to 
rotate the mark around the selected 
anchor point.
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Specifying Positioning Rules
Positioning rules determine the part of the template to which the mark is 
anchored, the anchor point on the template part, and the horizontal and 
vertical offset. In the case of rectangle and duplicating marks, you also 
specify the point on the mark that you want to use as the anchor point for 
positioning.

There are five SmartMarks that require you to specify positioning rules: 
rectangle marks, line marks, text marks, duplicating marks, and custom 
marks. Collation marks, fold marks, and crop marks use different options 
to specify positioning.

Table 2: Positioning rule settings for duplicating marks, line marks, rectangle 
marks, text marks, and custom marks.

1. From the Template anchor list, select Press Sheet.

2. On the template anchor diagram, select the top reference point.

3. On the mark anchor diagram, select the top reference point.

4. In the Horizontal offset box, type 0.25 in (6.35 mm).

5. In the Vertical offset box, type -0.125 in (-3.175 mm).

Setting Description

Template anchor list and diagram Determines the part of the template 
to which you want to anchor the 
mark, and the point on the template 
part to which you want to anchor 
the mark.

Mark anchor diagram Determines the point on the mark 
that you want to use as the anchor 
for positioning.

Note: This option is available only 
for smart rectangle marks, and 
smart duplicating marks.

Horizontal and Vertical offset boxes Type the amount that you want to 
offset the mark.
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Specifying Signature Placement
Once you have configured the positioning rules for the mark, you specify 
the remaining placement rules. 

Table 3: Additional placement rules for SmartMarks

Accept the defaults of Both, Bring to front, and Place on every 1th 
signature starting with signature: 1.

Setting Description

Front, Back, or Both options Determines which side(s) of the 
press sheet and/or media you want 
the mark to print.

Bring to front check box Prints the mark on top of other 
content.

Mirror on back check box Prints the mark in the same relative 
position on the back of the press 
sheet.

Place on every _th signature 
starting with signature: _ boxes

Determines the signatures on which 
you want the mark to print.

Restrict to section check box and 
box

Type the number of the section to 
which you want to restrict the 
mark.

Note: This option is available only 
for smart text marks, and smart 
collation marks.



Activity 1: Adding a Smart Duplicating Mark 87

Saving SmartMarks
When you are ready to use and/or save the mark, you can duplicate it, save 
a copy under a different name, or apply the changes to the existing mark.

Table 4: .Settings for saving SmartMarks

1. Because this mark is used in a later activity, click Save a Copy As to 
save the mark to the SmartMarks folder.

Note:  When you click OK and Duplicate or OK, this embeds the mark in 
the template only and does not create an external copy of the mark in the 
SmartMarks folder.

2. In the Save As box, accept the default name of Activity 1 
Colorbar.smk, and click Save.

3. Click OK to close the Edit Smart Dupmark dialog box.

Notice there is now a colorbar placed across the width of the press sheet. 
The colorbar.eps mark is 5 in x 0.25 in (127 mm x 6.35 mm). Preps repeats 
the mark as many times as possible within the area you specified. Any part 
of the mark that extends beyond this area is cropped. Because variable 
width is specified for the SmartMark, it automatically resizes itself to 
different media and/or press sheet sizes.

Option Description

OK and Duplicate button Creates a duplicate mark that you 
can modify and save under a 
different name.

Save a Copy As button The original mark remains 
unchanged. You type a name in the 
Save As box, and the mark is saved 
by default to the SmartMarks folder.

Apply button Allows you to see the effects of the 
mark and keep the dialog box open. 

OK button Saves the mark as is and closes the 
dialog box.
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Scenario

In this activity you learn how to add a smart collation mark to the same 
template and signature you used in Activity 1.

Smart Collation Marks Overview
Signature collation marks are used to identify each signature and ensure 
that the signatures are collated in the correct order and that none are 
missing or duplicated. Smart collation marks are available for both perfect 
bound and saddle-stitched binding styles and can include trailing text. 

To place smart collation marks, first number the pages on the template. If 
you renumber the pages later, you do not need to redo the collation 
mark—the collation mark automatically adjusts for the new numbering.

Saddle-stitched collation marks are always placed above the head of the 
low-folio page number. Perfect-bound collation marks are always placed 
between the highest and lowest folio pages. 

A smart collation mark whose binding style does not match that of the 
template, or contains high and low folio pages that aren’t placed next to 
each other, becomes invisible, can not be selected, and does not image. To 
correct the improper use of a smart collation mark, change the binding 
style specified for the mark to match the template binding style and/or 
renumber the high and low folio pages placing them next to each other.

Smart collation marks can be included in mark groups.

Activity

Activity 2: Adding a Smart Collation Mark
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Adding a Smart Collation Mark

1. Using the same signature and template from Activity 1, from the 
Template menu, choose Add SmartMark>Collation Mark.

2. In the Name box, type Activity 2 Collation Mark.

Table 5: Settings specific to collation marks

3. From the Binding list, select Perfect Bound.

Setting Description

Binding list Determines the binding style for the 
mark. Note: the binding style 
specified for the mark should be the 
same as the template binding style.

Type list Determines the type of collation 
mark.

Offset box Determines the distance the 
collation mark is offset from the 
Offset origin.

Offset origin box Determines the edge from which 
you want to offset the collation 
mark.

Width box Determines the width of the 
collation mark.

Length box Determines the length of the 
collation mark.

Step distance box Determines the size of each mark 
along the fold. If the distance is a 
negative number, the marks step in 
the opposite direction.

Optional text box Type any text that you want to trail 
the mark and print in the same 
color as the mark.

Restrict to section check box and 
box

For a multi-section template, this 
option determines the section to 
which you want to restrict the 
mark.
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Important:  Preps does not prevent importing or creating saddle-stitch collation 
marks inside perfect-bound templates, or vice versa. A smart collation mark 
whose binding style does not match that of the template, or contains high and 
low folio pages that aren’t placed next to each other, becomes invisible, can not 
be selected, and does not image. To correct the improper use of a smart 
collation mark, change the binding style specified for the mark to match the 
template binding style. Renumber the high and low folio pages to place them 
next to each other.

4. From the Type list, select Collation Mark A.

5. In the Offset box, type 0.5 in (12.7 mm).

6. From the Offset origin list, select Head.

7. In the Width box, type 0.25 in (6.35 mm).

8. In the Length box, type 7 in (177.8 mm).

9. In the Step distance box, type 0.25 in (6.35 mm).

Note:  In jobs with many signatures, the stepping cycle is repeated when 
marks reach a point defined by a maximum stepping distance.

10. In the Optional text box, type Smart Collation Mark.

11. Select the Front option, and accept the remaining defaults.

12. Because this mark is used in a later activity, click Save a Copy As to 
save the mark to the SmartMarks folder.

13. In the Save As box, accept the default name of Activity 2 Collation 
Mark.smk, and click Save.

14. Click OK to close the Edit Smart Collation Mark dialog box.
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Notice there is now a collation mark with trailing text between pages 1 and 
16 on the front of the press sheet.
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Scenario

In this activity you learn how to add a registration mark as a smart custom 
mark. Use the same template and signature as the previous activity.

Smart Custom Marks Overview
Preps ships with a number of smart custom marks. These marks are stored 
in the Marks folder. You can also create your own marks in a graphics 
program and save them as either EPS or TIFF files in the Marks folder.

Adding a Smart Custom Mark

1. Using the same signature and template from the previous activity, 
from the Template menu, choose Add SmartMark>Custom Mark.

2. In the Name box, type Activity 3 Reg Mark Bottom.

Table 6: Settings specific to smart custom marks

3. From the Image file list, select opencirc.eps.

4. On the Image anchor diagram, select the top middle point.

Activity

Activity 3: Adding a Smart Custom Mark

 See the Preps 5.0 User Guide for more information on creating custom marks 
and adding them to Preps.

Setting Description

Image file list Determines the image file to use in 
the mark.

Image anchor diagram Determines the point on the mark 
image to use as the anchor point.

Image rotation list Determines the amount by which to 
rotate the mark around the selected 
anchor point.
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5. From the Image rotation list, accept the default of 0.

6. Under Positioning Rule, from the Template anchor list, select 
Imposition with Bleed.

7. On the Template anchor diagram select the bottom middle point.

8. Under Horizontal offset and Vertical offset, accept the default of 0.

9. Accept the defaults of Both, Bring to front, and Place on every 1th 
signature starting with signature: 1.

10. Because this mark is used in a later activity, click Save a Copy As to 
save the mark to the SmartMarks folder.

11. In the Save As box, accept the default name of Activity 3 Reg Mark 
Bottom.smk, and click Save.

12. Click OK to close the Edit Smart Custom Mark dialog box.

13. The registration mark is placed on the gripper edge of the press sheet 
between pages 5 and 8. To view the mark, use the Zoom tool on the 
Tool palette.

Tip:  To zoom back out, click the Fit in Window tool on the Tool palette.
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Scenario

In this activity you learn how to add a smart text mark. Use the same 
template and signature as the previous activity.

Smart Text Marks Overview
There are two types of smart text marks. Flat identifier text and text marks. 
A Flat Identifier Text mark appears in exactly the same position on each 
side of a press sheet and/or media. A Text Mark is backed up (mirrored) on 
the opposite side of a press sheet and/or media. 

Adding a Smart Text Mark

1. Using the same signature and template from the previous activity, 
from the Template menu, choose Add SmartMark>Text Mark.

2. In the Name box, type Activity 4 Text Mark.

Activity

Activity 4: Adding a Smart Text Mark
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Table 7: Settings specific to smart text marks

Specifying Variable Text
When you add a smart text mark to a press sheet and/or media, you 
specify the text you want to print. You can also use variable text to 
automatically print information about the job, the template, or the part of 
the job being printed. All variable text begins with “$,” and is not case 
sensitive.

Setting Description

Text box Type the text or the variable to use 
in the mark.

Text size (pts) box Type the text size in points.

Angle list Determines the amount by which to 
rotate the mark around the selected 
text anchor point.

Text anchor diagram Determines the point on the text 
mark to use as the anchor point on 
the template. 

Flat identifier text check box Places the mark in exactly the same 
position on each side of the press 
sheet and/or media. 

Restrict to section check box and 
box 

For a multi-section template, this 
option determines the section to 
which you want to restrict the 
mark.
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Table 8: Predefined variables that can be printed in text marks

1. In the Text box, type Sig$sig Side$side $color $date $time.

2. In the Text size (pts) box, type 24.

3. In the Angle box, accept the default of 0.

4. On the Text anchor diagram, select the top point.

5. Select the Flat identifier text check box.

6. Under Positioning Rule, from the Template anchor list, select 
Imposition with bleed.

This Variable... Prints This in the Text Mark

$COMMENT The text in the Comment box in the Print dialog 
box

$COLOR The color name for the current separation

$CUSTOMER The customer ID number specified in the Job 
Notes dialog box (Mac) or the Job Information 
dialog box (Windows)

$DATE The date the job was printed

$JOBDATE The date the Preps job was last saved

$JOBID The job ID number specified in the Job Notes 
dialog box (Mac) or the Job Information dialog 
box (Windows)

$JOBNAME The job file name

$JOB_TITLE The job title

$SIDE The press sheet side (A = front or B = back). For 
multi-web signatures, additional sides are labeled 
C, D, etc.

$SIG The number of the current job signature

$TIME The time the job was printed

$WEB The web number of the press sheet
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7. On the Template anchor diagram, select the bottom, left point.

8. In the Horizontal offset box, type -0.125 in (-3.175 mm).

9. In the Vertical offset box, type -0.5 in (-12.7 mm).

10. Accept the remaining defaults of Both, Bring to front, and Place on 
every 1th signature starting with signature: 1.

11. Because this mark is used in a later activity, click Save a Copy As to 
save the mark to the SmartMarks folder.

12. In the Save As box, accept the default name of Activity 4 Text 
Mark.smk, and click Save.

13. Click OK to close the Edit Smart Text Mark dialog box.

14. Notice that the text mark is placed on the gripper edge of the press 
sheet in the lower left corner. To view the mark, use the Zoom tool on 
the Tool palette.

Note:  To zoom back out, click the Fit in Window tool on the Tool palette.
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Editing SmartMarks
You edit a SmartMark in the appropriate Edit Smart Mark dialog box. You 
can edit only one mark at a time. 

Select the text mark you added in the previous step, and from the Edit 
menu, choose Get Information.

Tip:  You can open the Edit dialog box for an existing SmartMark by double-
clicking the mark on a Macintosh or right-clicking the mark on Windows.

Specifying SmartMark Color
You can specify color for the following SmartMarks:

• Rectangle marks

• Line marks

• Text marks

• Collation marks

• Fold marks

1. In the Edit Smart Text Mark dialog box, click Mark Color.

In the Template Mark Color dialog box, you specify the color and halftone 
screen percentages for the mark. 
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Table 9: Mark color settings

2. Click the Process color option. Type 80 in the %Cyan box, and in the 
%Magenta box, type 60. Type 0 in the %Yellow and %Black boxes.

3. Click OK to close the Template Mark Color dialog box.

Setting Description

All separations option Prints the mark on all separations. 
You specify the halftone screen 
percentage for the mark in the 
%Screen box.

Spot Color, SSICustomColor, and 
%Screen option

Assigns a custom color to a mark. 
Type a number in the 
SSiCustomColor box as an identifier. 
The SSi custom color number is a 
placeholder that can be mapped to 
any spot color or process color 
equivalent in the Print dialog box 
on the Color Separations tab when 
you print. You specify the halftone 
screen percentage for the mark in 
the %Screen box.

Process color option Prints the mark in process color. 
You specify the halftone screen 
percentages in the %C, %M, %Y, 
and %K boxes. The mark prints 
with the process color build you 
have specified.
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4. Click OK again to close the Edit Smart Text Mark dialog box.

Note:  The mark color is displayed when you preview and print the job.

5. From the File menu, choose Save Template to save the template to the 
Templates folder. 

6. Close the template.
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Scenario

In this activity you create a new job, and use the SmartMarks template 
from the previous activities to view the marks in the Preps Previewer.

Using the SmartMarks Template in a Job

1. From the File menu, choose New Job, then Mixed Files -> PostScript.

2. In the Run List window, click Add Files.

3. From the Learning Preps:Activity Files:Art of Imagery:PS:US (Metric) 
folder, select Cover.sep and Chapter3_15pg.sep (Cover_A4.sep and 
Chapter3_15pg_A4.sep), and click Add.

4. Select the Add all pages to run list check box.

5. Click Done.

6. In the Signature List window, click Signatures.

7. From the Binding Style list, select Perfect Bound.

8. Select the SmartMarks template you created in the previous activities, 
and click Auto Select.

9. Click OK to close the Signature Selection window.

10. In the signature list, select the signature, and from the File menu, 
choose Preview.

11. To view the page content in addition to the marks, click Preview.

Activity

Activity 5: Using the SmartMarks Template in a Job
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12. Click Close to close the Preview window.
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Scenario

In this activity you learn how to create new SmartMarks independent of a 
template. You also modify an existing SmartMark to create three additional 
copies, each with its own unique properties.

Note:  All of the SmartMarks can be created independent of a template. Smart 
crop marks are used in this activity for the purpose of teaching the feature.

Creating Smart Crop Marks
When you add smart crop marks to imposition pages in a template or 
independent of a template, the marks are added to all pages. To add crop 
marks to specific pages, you must use static crop marks. Smart crop marks 
can be added around only the outside of the imposition, or to all four 
corners of each imposed page.

1. From the File menu, choose New SmartMark>Crop Marks.

2. In the Edit Crop.smk dialog box, in the Name box, type Activity 6 Smart 
Crop.

3. In the Length box, accept the default of 0.25 in (7 mm).

4. In the Offset from page box, accept the default of 0.125 in (3 mm).

5. Clear the Place crop marks on outside of imposition check box.

6. Accept the remaining defaults of Both and Bring to front.

Activity

Activity 6: Creating SmartMarks Independent of a 
Template
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7. Click Save.

8. In the Save As box, accept the default name of Activity 6 Smart 
Crop.smk.

9. Click Save to save the smart crop marks to the SmartMarks folder.

Creating Custom Marks
In this part of the activity, you open the smart registration mark you 
created in Activity 3, and modify its properties to create three additional 
registration marks.

1. From the File menu, choose Open SmartMark.

2. In the Marks:SmartMarks folder, select Activity 3 Reg Mark Bottom, 
and click Choose.

3. Under Positioning Rule on the Template anchor diagram, select the 
top, middle point.
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4. Click Save As, and in the Save As box, type Activity 6 Reg Mark Top.

5. Click Save to save the mark to the SmartMarks folder.

Note:  The Edit Activity 3 Reg Mark Bottom.smk dialog box should still be 
displayed.

6. Under Positioning Rule on the Template anchor diagram, select the 
left, middle point.

7. Click Save As, and in the Save As box, type Activity 6 Reg Mark Left.

8. Click Save.

9. Under Positioning Rule on the Template anchor diagram, select the 
right, middle point.

10. Click Save As, and in the Save As box, type Activity 6 Reg Mark Right.

11. Click Save.

12. Click OK to close the Edit Activity 3 Reg Mark Bottom.smk dialog 
box.
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Scenario

In this activity you learn how to create a mark group. You use the 
SmartMarks created in the previous activities to create the mark group.

Creating a Mark Group
In Preps 5.0, you can create mark groups at the operating-system level or 
from within Preps by saving them from the Template Editor window to a 
specific SmartMark group folder. Only SmartMarks can be included in a 
mark group; static marks cannot be included. 

1. In the Finder or Windows Explorer, navigate to the Marks:SmartMarks 
folder. Create a new folder in the SmartMarks folder, and name it 
Learning Guide Mark Group.

2. Drag the following SmartMarks into the Learning Guide Mark Group 
folder: 

• Activity 1 Colorbar.smk

• Activity 2 Collation Mark.smk

• Activity 3 Reg Mark Bottom.smk

• Activity 4 Text Mark.smk

• Activity 6 Reg Mark Left.smk

• Activity 6 Reg Mark Right.smk

• Activity 6 Reg Mark Top.smk

• Activity 6 Smart Crop.smk

Activity

Activity 7: Creating a Mark Group 
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Scenario

In this activity you learn to apply the mark group you created in the 
previous activity to a template.

Applying a Mark Group to a Template
You apply mark groups to a template by importing them into the template. 
You can add a mark group to all signatures, a particular signature, a 
particular web, or to a particular web on a particular signature. If you 
choose a particular web, no check is made that web actually exists on that 
particular signature or signatures.

You import mark groups into a template in the Import SmartMarks dialog 
box. Mark groups are distinguished from individual marks in the left 
column by the disclosure triangle, and in the right column by the green 
circle.

1. From the File menu, choose Open Template>From Templates Folder.

2. Select the SmartMarks template from the previous activities, and click 
Open.

3. From the Template menu, choose Add Signature.

4. In the Signature Name box, type Mark Group.

5. Accept the remaining defaults, and click OK.

6. From the Template menu, choose Create Imposition.

7. Accept the defaults in the Create Imposition window, and click OK.

8. Use the Numbering tool on the Tool palette to number the pages 
exactly like the 16-page Sheetwise signature.

9. From the Template menu, choose Import SmartMarks.

Activity

Activity 8: Applying a Mark Group to a Template
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10. In the External SmartMarks and mark groups column, click the 
Learning Guide Mark Group folder, and then click the right arrow 
button.

11. From the Destination signature list, select the Mark Group signature. 

12. Click OK.

Note:  If you import the same mark group twice to the same location, an 
exclamation point icon appears next to the mark group name in the right 
column. By default, Preps removes the mark group previously imported, and then 
imports the current contents of the mark group. 

See the Preps 5.0 User Guide for more information on importing mark groups.

Notice that all of the marks in this mark group are automatically placed on 
the Mark Group signature.

13. From the File menu, choose Save Template.
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Module Wrap-Up
In this module, you learned to:

• Identify the two types of template marks

• Identify where Preps stores marks

• Add a smart duplicating mark to a template

• Add a smart collation mark to a template

• Add a smart custom mark to a template

• Add a smart text mark to a template

• Save SmartMarks

• Edit SmartMarks

• Specify SmartMark color

• Use a template containing SmartMarks in a job

• Create SmartMarks independent of a template

• Create a mark group

• Apply a mark group to a template
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Module Objectives
By the end of this module, you will be able to:

• Preview Preps jobs

• Use the zoom function to preview more detail

• Preview individual colors

• Use rulers and guides to line up page elements
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Previewing Preps Jobs

Overview
The Preps previewer RIPs the page content and allows you to view pages 
and imposed signatures. You can view either a composite view of all colors, 
or individual color plates.

1. With a Preps job open, select a page in either the file list or the run list.

2. From the File menu, choose Preview. The previewer opens and a 
mock-up view of the page appears.

3. Click Preview. This starts the Adobe CPSI RIP that is used for 
previewing. The RIPed page appears.

Previewing a Signature

1. Select a signature in the signature list.

2. From the File menu, choose Preview.

3. If the signature is double-sided, from the Signature list at the top right 
of the previewer dialog box, select the side you want to preview.

4. Click Preview.
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Zooming
You can zoom in to re-RIP a section of a page to get a more detailed view. 
Click and drag to marquee an area, or use one of the following keyboard 
shortcuts:

Macintosh
• Zoom in: COMMAND++ (plus)

• Zoom out: COMMAND+- (minus)

• Fit in window: COMMAND+0 (zero)

Windows
• Zoom in: CONTROL++ (plus)

• Zoom out: CONTROL+- (minus)

• Fit in window: CONTROL+0 (zero)

Previewing Individual Colors
The default setting is to preview in composite mode. To preview an 
individual color plate, select the color in the list, then click Preview and/or 
Preview Again.
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Show Trim Box
The trim box is determined by the page size on the signature that is used in 
the job, so only run list pages can be viewed with a trim box. The trim box 
shows as a red outline in the previewer window, and its purpose is to allow 
you to see how the page information fits.

Process OPI
OPI processing is available only in Preps Pro and Preps XL; it is not 
available in Preps Plus. When the Process OPI check box is selected, the 
previewer displays the images using the OPI settings you have configured.

Rulers and Guides
The previewer has rulers and guides you can use to make sure elements line 
up correctly. 

Changing the Origin (0,0) Point of the Ruler

1. Click the intersection of the ruler in the box in the lower-left corner of 
the Preview window, and drag it to the new position. 

2. Double-click the intersection of the ruler in the box in the lower-left 
corner of the Preview window to return the origin point to the default 
setting.

Adding Guides

Click the horizontal or vertical ruler and drag a guide to the position 
you want. Press and hold the shift key to snap the guide to a ruler 
mark.

Removing a Guide:

Drag the guide back to the ruler.
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Module Wrap-Up
In this module, you learned to:

• Preview Preps jobs

• Use the zoom function to preview more detail

• Preview individual colors

• Use rulers and guides to line up page elements
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Module Objectives
By the end of this module, you will be able to:

• Apply page offsets to source files and run list pages using the Previewer

• Apply page offsets to a source file, run list page, or an entire job 
without using the Previewer

• Identify what a source file bounding box represents, and how to ignore 
the bounding box information in Preps

• Apply page scaling adjustments to run list pages

• Rotate run list pages
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Page Offsets

Overview
Page offsets allow you to precisely adjust the position of pages. You can 
adjust page offsets in several places, including in the previewer. There are 
three ways to adjust page offsets to compensate for alignment problems 
with source files:

• Applying offsets to the entire job

• Applying offsets to a selected file

• Applying offsets to selected pages
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Adjusting Page Positions in the Previewer

Changing Page Offsets for the Entire Job
You can apply the same offset amounts to all the source files in a job. This 
adjustment is useful if you want to move the page away from the binding 
for easier readability, or if you change the binding method for a job.

When you change the offsets for a job, you can specify different offset 
amounts for odd and even pages. 

In the previewer, type the offset amounts in the All Even and All Odd 
boxes under Page Position Adjustment. 

These offsets are recorded in the Layout Details dialog box and affect all 
the pages in the entire job.
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Changing Page Offsets for a Source File
When you preview pages from the file list, you can apply horizontal and 
vertical offsets to all the odd pages, all the even pages, or all the pages in the 
source file.

1. In the previewer, place the cursor over the pages, press the COMMAND 
(CONTROL) key, then click and drag the page to the new position.

Or:

In the Page Position Adjustment area, type the new coordinates in the 
File List boxes.

2. Click Odd Pages, Even Pages, or All to apply the offsets to the pages.

Tip:  To move the pages up or to the right, use positive numbers. To move the 
pages down or to the left, use negative numbers. The direction of movement is 
relative to the orientation of the imposed page.
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Changing Page Offsets for Run List Pages
When you preview pages from the run list, you can apply offsets the same 
way as for the pages in the file list, but you can choose to apply offsets to 
just a single page, or to all the selected pages.

These adjustments are applied two ways:

• Click Current to apply offsets to only the page currently being 
previewed

• Click Selected to apply offsets to all the run list pages you selected to 
preview

The offset amounts you type in the previewer appear in the Run List 
window next to the page icons.

Adjusting Page Positions Without Using the Previewer

Changing Page Offsets for the Entire Job
You can make page offset adjustments without using the previewer. 

1. From the Job menu, choose Layout Details.

2. Under Page Position Adjustment, type the offset amounts in the 
Horizontal and Vertical boxes.

Note:  The amount of the page offsets for the entire job, files, and run list pages 
are added together. You can see the cumulative total of adjustments for a page 
only when you view a run list page in the previewer.
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Changing Offsets for a Source File
You can make source file adjustments without using the previewer.

1. Select the file in the file list.

2. From the Edit menu, choose Get Information.

3. Under Page Position Adjustment, type the offset amounts in the 
Horizontal and Vertical boxes for the Odd Pages and Even Pages.

Changing Offsets for Run List Pages
You can make run list page adjustments without using the previewer.

1. Select the page(s) in the run list.

2. From the Job menu, choose Modify Run List Page.

3. Under Page Position Adjustment, type the page offset amounts in the 
Horizontal and Vertical boxes.
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There are four options for Page Position Adjustment:

• No Change: There is no change to the current page position.

• Centered: The center point of the bounding box of the source file page 
is positioned to the center point of the template page.

• Set to: You type a specific position for the lower-left corner of the page.

• Change by: You type the amount you want added to or subtracted 
from the page’s current position.

Information about the offsets that are applied to run list pages appears in 
the Run List window next to the page icon. This information does not 
include any source file or job offset adjustment amounts.

Source File Bounding Boxes
Source files contain information about the size of the imageable area of a 
page. This is known as the bounding box. Some desktop applications 
describe the bounding box as the trim size of the page, while others use the 
trim plus bleed or the elements on the page.

In some cases, you may not want Preps to use the bounding box to position 
the pages. For example, if a job contains pages that have different sized 
bounding boxes for every page, using the bounding box for positioning the 
pages requires you to set different page adjustment amounts for every 
page. It is much easier to correctly position multiple pages when they 
require the same offset amounts.

Preps has a setting that causes it to ignore the bounding box information 
and use the PostScript origin point to position the pages. The PostScript 
origin point is not usually the same as the trim size of the page, but it is the 
same for all files created from the same desktop application, so all pages 
require the same offset amount.
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There are two ways for Preps to ignore the bounding box:

• Globally: If you select the Ignore bounding box by default check box 
on the General tab of the Preferences dialog box, Preps ignores the 
bounding box for all source files that are subsequently added to Preps 
jobs. This method can be used if you have many files with unacceptable 
bounding boxes.

• Individual files: If you select the Ignore bounding box information 
check box in the File Information dialog box (select a file in the file list, 
then go to the Edit menu and choose Get Information), Preps ignores 
the bounding box for only the selected file. This method can be used if 
only some of the files have unacceptable bounding boxes.

The bounding box for a PostScript or EPS source file is usually the same as the 
trim size of the page. The bounding box for a TIFF source file is the same as the 
image size.
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Scenario

This job is a 17" x 22" (430 mm x 560 mm) poster, plus bleeds. The 
supplied file is an EPS that was created in an illustration program. These 
types of files include the bleed amount as part of the page size, so when the 
file is added to a Preps job, the lower left corner of the outside edge of the 
bleed, rather than the trim size of the page, is positioned in the lower-left 
corner of the Preps template page.

1. From the File menu, choose New Job, then Mixed Files -> PostScript.

2. From the Learning Preps:Activity Files:Dog Show Poster-Ad:US 
(Metric) folder, add Dog-Show-17x22.fh8.eps (Dog-Show-Poster-
A3.fh8.eps) to the file list and to the run list.

3. In the signature list, click Signatures.

4. From the Binding Style list, select Flat work.

5. From the Sample Templates:US (Metric) folder, select 17x22 poster 
(430x560mm poster), and click Auto Select.

6. Click OK to close the Signature Selection window.

7. Select the page in the run list and preview it (from the File menu, 
choose Preview; then click Preview).

8. Make page adjustments either by moving the page in the Previewer - 
hold down the COMMAND key (CONTROL key on Windows), then click 
and drag the page image - or by entering adjustments in the run list 
boxes in the palette at the right side of the Previewer window.

9. When the page is correctly positioned, click Current, then click Close.

10. You see the offset amount in the run list window.

The page should now be correctly positioned.

Activity

Activity 1: Making Manual Page Adjustments
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Scenario

This is an alternate method that can be used to obtain the same results as 
Activity 1: Making Manual Page Adjustments.

1. Using the job from Activity 1: Making Manual Page Adjustments, select 
the page in the run list.

2. From the Job menu, choose Modify Run List Page.

3. Under Page Position Adjustment, select Centered from the list, then 
click OK.

4. Notice the word Centered and the offset amount in the run list 
window.

5. To view the results, select the page in the run list, then from the File 
menu, choose Preview.

6. Click Preview.

The page should now be correctly positioned.

Activity

Activity 2: Using Autocentering to Make Page 
Adjustments
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Scaling
You can scale (enlarge or reduce) run list pages proportionally (using the 
same amounts for the horizontal and vertical dimensions) or 
anamorphically (using different amounts for the horizontal and vertical 
dimensions).

1. Select the page(s) in the run list.

2. From the Job menu, choose Modify Run List Page.

3. Under Page Scaling Adjustment, select the desired Page Scaling 
Adjustment option in the list.

There are four options for Page Scaling Adjustment:

• No Change: There is no change to the current page size.

• Scale to fit: The page is scaled so the bounding box of the source file 
fits in the template page without losing any page data. The entire page 
is scaled proportionately and positioned in the lower-left corner of the 
template page. If the page does not exactly fit in both dimensions, there 
is extra space at the top or right edge of the page.

• Set to: You type a specific amount for page scaling.

• Change by: You type the percentage of scaling you want to apply to the 
existing amount of page scaling.

Information about the scaling that is applied to run list pages appears in 
the Run List window next to the page icon. 
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Scenario

The supplied file is a letter-size magazine cover that the customer wants to 
reprint as a 17" x 22" (A2) poster.

1. From the File menu, choose New Job, then Mixed Files -> PostScript.

2. From the Learning Preps:Activity Files:Space Magazine:US (Metric) 
folder, add Space Magazine Cover.ps (A4 Space Mag Cover.ps) to the 
file list and to the run list.

3. In the signature list, click Signatures.

4. From the Binding Style list, select Flat work.

5. From the Sample Templates:US (Metric) folder, select 17x22 poster 
(A2 Poster), and click Auto Select.

6. Click OK to close the Signature Selection window.

7. Select the page in the run list.

8. From the Job menu, choose Modify Run List Page.

9. Under Page Scaling Adjustment, select Scale to Fit from the list, then 
click OK.

10. Notice the words Scale To Fit and the scaling percentage amount in the 
run list window.

Activity

Activity 3: Using Autoscaling to Make Page 
Adjustments
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11. To view the results, select the page in the run list, then from the File 
menu, choose Preview.

12. Click Preview.

The page should now be correctly scaled.



Rotation 131

Rotation
You can rotate run list pages in 90-degree increments. For example, if a 
source file page is created with a landscape orientation and you want to use 
it in a portrait-oriented template page, you can rotate the page in the run 
list so it fits the template page.

1. Select the page(s) in the run list.

2. From the Job menu, choose Modify Run List Page.

3. Select the Rotation option in the list.

There are eight options for Rotation:

• No Change: There is no change to the page’s current rotation.

• Change by 90 Degrees: The page rotates 90 degrees counterclockwise 
from its current orientation.

• Change by 180 Degrees: The page rotates 180 degrees 
counterclockwise from its current orientation.

• Change by 270 Degrees: The page rotates 180 degrees 
counterclockwise from its current orientation.

• Set to No Rotation: The page reverts to its original orientation, with no 
rotation.

• Set to 90 Degrees: The page rotates 90 degrees counterclockwise from 
its original orientation.
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• Set to 180 Degrees: The page rotates 180 degrees counterclockwise 
from its original orientation.

• Set to 270 Degrees: The page rotates 270 degrees counterclockwise 
from its original orientation.

The page icon in the Run List window rotates to the appropriate 
orientation. 
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Module Wrap-Up
In this module, you learned to:

• Apply page offsets to source files and run list pages using the Previewer

• Apply page offsets to a source file, run list page, or an entire job 
without using the Previewer

• Identify what a source file bounding box represents, and how to ignore 
the bounding box information in Preps

• Apply page scaling adjustments to run list pages

• Rotate run list pages
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Module Objectives
By the end of this module, you will be able to:

• Specify fitting options

• Specify tiling options
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Fitting Options

Overview
Fitting options determine how the press sheet fits on the selected media 
size, or page size. The media size is the size of the film or plate onto which 
a Preps press sheet is imaged (see Page Size on page 34). Fitting options 
include reducing, enlarging, rotating, and centering the press sheet image.

From the File menu, choose Fitting/Tiling Setup.

The fitting options are:

• Tile if necessary: This option activates automatic tiling. If the size of 
the press sheet is larger than the size of the media, Preps divides the 
press sheet into tiles.

• Reduce image to fit: If the press sheet size is larger than the size of the 
media, Preps reduces the press sheet so it fits on the media.

• Enlarge image to fit: If the press sheet size is smaller than the size of 
the media, Preps enlarges the press sheet so it fits on the media.

• Auto rotate for best fit: Preps automatically rotates the press sheet for 
the best fit on the media. This option is available only for media sizes 
that do not have punch coordinates.
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• Center image on media: Preps centers the press sheet on the media. 
This option is available only for media sizes that do not have punch 
coordinates.

• Border: This option specifies an amount for the border around the 
press sheet. This option can be used to include marks that appear 
outside the boundaries of the press sheet, or if an output device cannot 
print all the way to the edge of the media. Specifying a border when 
using the Reduce image to fit option ensures that the image is not cut 
off at the edges.

Tiling Options

Overview
Tiling options are used for press sheets that are larger than the imageable 
area of the output device. Tiles can be aligned using tile marks and 
manually stripped together to create a single form, or flat. The flat is 
exposed to create a fully imposed printing plate. Tiling is generally used for 
small-and medium-format imagesetters.

When tiling is enabled, if you select a different media size or a different 
output device, Preps automatically recalculates the tiling for the new media 
size.

1. From the File menu, choose Fitting/Tiling Setup.
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2. Under Fitting Options, select the Tile if necessary check box. The 
fitting options become unavailable and the tiling options become 
available.

The tiling options are:

• Least media waste: This is the default option. Preps tiles the press 
sheet in the direction that uses the least amount of media.

• Least manual stripping: Preps tiles the press sheet in the direction that 
requires the least manual stripping, typically using the fewest tiles.

• Vertical tiling: Preps orients all tiles vertically.

• Horizontal tiling: Preps orients all tiles horizontally.

• Back mirrors front: Preps tiles the back side of the press sheet so it is a 
mirror image of the front side.

• Allow split pages: This option allows tiles to contain partial pages, so 
when tiles overlap in the middle of a page, the page appears on all tiles. 
The default setting is for this check box to be cleared, so tiled press 
sheets contain only complete pages. However, if a page is positioned so 
that it does not appear entirely on any one tile, Preps displays an error 
message. In that case, you must enable this option.

• Auto place tile marks: This option automatically places tile marks in 
the overlapping areas of adjacent tiles. These marks are used to align 
the tiles when they are stripped together. For imposed pages, tile marks 
are placed in the gutters. For independent pages, tile marks are placed 
between the pages. If a press sheet does not have gutters, or if there is 
no space between independent pages, Preps does not add tile marks. 
You cannot select, move, or edit tile marks that are placed 
automatically.

Tiling Dimensions
The settings under Tiling Dimensions affect the placement of the tiles on 
the selected media size.

The tiling dimension options are:

• Press sheet border: This option specifies an amount for the border 
around the press sheet. This option can be used to include marks that 
appear outside the boundaries of the press sheet, or if an output device 
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cannot print all the way to the edge of the media. The amount you type 
for the border is added to the left and bottom sides of the press sheet 
and can affect the number of tiles produced. 

• Minimum tile overlap: This setting determines the minimum amount 
of overlap for tiles. As Preps calculates the tiles, the overlap area can be 
larger than the amount you specify, but never smaller. This setting can 
affect the number of tiles produced. If Preps determines that only one 
tile is needed, this setting is ignored.

• Punch to image margin: When printing to an output device that has a 
punch, this setting ensures that the imageable area of the tile (press 
sheet plus press sheet border) does not appear in the punch area. If 
Preps determines that only one tile is needed, this setting is ignored.

• No punch margin: If the output device does not have a punch, and the 
job has only one tile, you may add a strip to the bottom of the press 
sheet by specifying a value for No punch margin. This allows an image-
free area for conventional punching.

Show Tiles Tool
When the Tile if necessary check box is selected in the Fitting/Tiling Setup 
dialog box, and the Show/Hide Tiles tool is selected in the template, you 
can view how the tiles fit on the selected signature.
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The individual tiles are represented by diagonal lines. The area where tile 
overlap is represented by a cross-hatch pattern.
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Module Wrap-Up
In this module, you learned to:

• Specify fitting options

• Specify tiling options
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Module Objectives
By the end of this module, you will be able to:

• Describe the five output options

• Print imposed output to a printer, create a PostScript file, output an 
Adobe Job Ticket, discard the output, create a Job Description File 
(JDF), and/or create a CIP3 cutting data file (PPF)

• Specify a print range, output format, imaging options, and halftone 
screening

• Specify color separations

• Enable PostScript level 2 options
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Printing
Printing a job from Preps is similar to printing from other desktop 
applications.

Output Options
There are five printing options:

• Sending a PostScript file

• Thumbnails

• Template mock-up

• Job mock-up

• Imposed output

Thumbnails, template mock-ups, job mock-ups, and imposed output can 
be printed as composite or color separated.
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Sending a PostScript File
Preps has a built-in option for sending individual PostScript source files 
directly to an output device, bypassing any processing by Preps. This 
option can be used to for isolate PostScript problems. When you send a 
PostScript file to the output device, if an error occurs or the file does not 
print, this usually means the problem is with the PostScript file and not 
with Preps. However, even if the file prints correctly when it is sent directly 
to the output device, if it is made incorrectly, it may not print correctly 
when it is imposed in Preps. 

Thumbnails
Thumbnails are typically printed on a proofing printer, such as a laser 
printer. In a thumbnail layout, the job pages are laid out in the order in 
which they appear in the run list. You choose how many pages you want to 
print on each sheet by specifying the horizontal and vertical numbers. In 
the example below, 20 thumbnails appear on each sheet.

Thumbnails can be used to check the order of the pages in the run list, and 
to isolate PostScript problems. When you print thumbnails, Preps 
processes the pages on each sheet in reverse order. For example, if you print 
2 x 2 thumbnails of pages 1-4 in the run list, Preps process page 4 first, then 
pages 3, 2, and 1. This tests the source file for DSC compliance.

See the Preps 5.0 User Guide for information on DSC compliance and PostScript 
files.
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Template Mock-Ups
Template mock-ups provide a quick way to verify that the template is 
created correctly, and to test the integrity of the template and marks. Page 
information from the source files does not print. Template mock-ups show 
numbered boxes that reflect the page numbering in the Preps template. All 
template marks and page marks print.

Job Mock-Ups
Job mock-ups provide a quick way to verity that the page numbering is 
correct on the imposition. Page information from the source files does not 
print. Job mock-ups show numbered boxes that reflect the order in which 
the run list pages are flowed through the signatures in the template. All 
template marks and page marks print.

Imposed Output
Imposed output includes all marks and source file page information 
imposed into signatures. This is considered to be final output.

Status Window
When you print from Preps, a log of the printing process, including any 
PostScript errors (Macintosh only), appears in the Status window. 
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To display the status window when Preps is not printing:

From the Windows menu, choose Show Status Window.

To hide the status window:

From the Windows menu, choose Hide Status Window.

Print Settings

To print a Preps job, from the File menu, select Print.

Send to
When you print a Preps job, you can send it to a printer, create a PostScript 
file, output an Adobe Job Ticket, discard the output, create a Job 
Description File (JDF), or create CIP3 cutting data files (PPF).

• Printer: The job is sent directly to the selected output device.

• PS File: The job is printed to one or more PostScript files, which can be 
sent to other locations or downloaded to an output device. When you 
select this option, Preps prompts you for a file name and a location to 
save the file.
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• Adobe Job Ticket: An Adobe Portable Job Ticket is a specification 
about how to impose and print a job. This option creates an Adobe 
Portable Job Ticket for workflows such as Adobe Extreme that is saved 
in the designated location.

• Discard: This option discards the output, and and can be used to verify 
that a job can be successfully processed, without wasting output media 
or disk space.

• JDF: Although the Job Description Format is not widely implemented 
in the industry at this time, Creo sees substantial further potential for 
JDF to increase connectivity among its own suite of applications, as 
well as integration with third-party workflows.

• PPF: The Print Production Format (PPF) is a cutting description file 
that allows pre-setting a cutter for the placement and order of cuts.

Device
You can select any device that is available to Preps directly from the Print 
dialog box. The connection information appears under the name of the 
selected device.

Copies
You enter the number of copies you want to print.

Comment
The text in the Comment field prints if a $Comment text mark is present 
on the template used for the job.
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General Tab

Overview
Some of the options in this tab change depending on whether or not tiling 
is enabled in the Fitting/Tiling Setup.

Specify print range
If this option is de-selected, the entire job prints. If you select this option, 
you can select specific pages, signatures, webs, or tiles to print.

Print sides that include pages
This allows you to specify a page or group of pages to print. Preps prints 
the entire side of a press sheet that contains those pages. Use a dash to print 
a range of pages, and a comma to separate pages or ranges of pages.

Print signatures
This allows you to specify a range of signatures, sides, webs, and/or tiles to 
print.
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Range
Enter the numbers of the signatures you want to print. Use a dash to print 
a range of signatures, and a comma to print non-consecutive signatures.

Sides
You can print the front, back, or both sides of a press sheet.

Webs
A web is typically two or more press sheets that fold and bind together as a 
signature. You can print all webs, or specify a range of webs to print.

X Tiles and Y Tiles
The X and Y refer to the horizontal and vertical numbers of the tiles. The 
diagram at right shows how the four tiles that make up a signature are 
numbered.

Output Format

Divide output
You can print a full job with all Preps versions. With the Pro and Plus 
versions, you also can print a job in parts. The default setting is Divide 
output, de-selected this causes the entire job to print. If the job prints to a 
PostScript file, a single file is created for the whole job. When you divide a 
Preps job into parts, if one part fails to print, the remaining parts can still 
print.

This feature is used for:

• Creating a PostScript file for a large job and dividing it into smaller 
parts to fit on small disks

• Multiplexing (dual RIPs)

• Printing large jobs overnight that may error, in which case the RIP can 
continue to the next file in the job



152  Module 9 – Printing

 

To divide the Preps output, select Divide Output and select one of the 
options from the list.

Divide by: Signature
Each signature prints separately. If the job prints to a PostScript file, a 
separate file is created for each signature.

Divide by: Press Sheet
Each press sheet prints separately. If it is a multiple-web job, each web 
(sides A and B, C and D, etc.) prints separately. If the job prints to a 
PostScript file, a separate file is created for each press sheet.

Divide by: Side (or Tile)
Each side of each press sheet prints separately. If tiling is being used, each 
tile prints separately. If the job prints to a PostScript file, a separate file is 
created for each side or tile.

Divide by: Separated Side (or Tile)
Each separation for each side or tile prints separately. If the job prints to a 
PostScript file, a file is created for each separation of each side or tile. This 
option is commonly used for printing computer-to-plate. 

Reverse order
The signatures print in reverse order, from last to first.

Collated
Multiple copies of a job print in collated sets; most often used for 
on-demand work.

Double-sided
The job pages print on both sides of a sheet of media, provided the selected 
output device supports duplexing. This is most often used for on-demand 
work.
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Imaging Options

Color Separation - None
This produces composite ouput for printing color proofs or single-color 
jobs.

Color Separation - In-RIP
This option tells Preps to include instructions so that the RIP generates the 
separations. This option is available only if you have a Level 2 or PostScript 
3 RIP with color-separation capabilities and have enabled PostScript Level 
2 in-RIP separations in Device Configuration.

Color Separation - Host-based
When you select Host-based, Preps creates the color separations using its 
built-in PostScript Level 1 color separator. You select how you want Preps 
to group the output.

• Sort by: Page: Preps outputs all the CMYK plates plus spot colors for 
each page, followed by subsequent sets for the remaining pages.

• Sort by: Color: Preps outputs the plates for all signatures or tiles in this 
order: cyan, magenta, yellow, black, and spot colors in the order in 
which they appear on the Color Separation tab of the Print dialog box.

Tip:  The Negatives option overrides any similar options built into the RIP, but 
does not override options set at the marking engine. If it is selected both in 
Preps and on the output device, their effects cancel each other. We recommend 
that you always set them on the output device, rather than in Preps.
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Negatives
The colors black and white are reversed to create a negative image (not 
available in the XL version).

Emulsion side down
The job is right-reading when the output media is viewed with the 
emulsion side down. If this check box is deselected, the output is right-
reading when viewed with the emulsion side up (not available in Preps 
XL).

Embed CIP3 Cutting Data
If a job is printed as an Adobe Job Ticket, you have the option of including 
the CIP3 cutting data. This option is not available if you print a PostScript 
file, JDF, or directly to an output device. If a job is printed as PPF files, this 
option is not available because PPF files already include the CIP3 cutting 
data.

Halftone Screening

Override line screen
Selecting this option ensures that the halftone screens of the images in your 
final output are consistent, and of the quality you want. By checking this 
option, you set a minimum, or threshold, halftone screen value in the 
Override above box. Any halftone screen value in your source files greater 
than this is overridden by Preps.

Override spot shape
If you override the halftone line screen, you can also override the spot 
shape of the halftone screens to ensure consistency in your final output. 
Preps uses the spot shape selected in the Device Configuration dialog box 
for composite output; Preps uses the spot shape selected on the Color 
Separations tab for color-separated output.
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Color Separations Tab

Overview
In addition to source files containing black only, Preps accepts PostScript, 
EPS, DCS, TIFF, and PDF source files that contain pre-separated or 
composite color. If your source files are pre-separated, you must print 
host-based separations from Preps. However, if your source files are 
composite, you can print composite or separated. When printing 
separations, you can change process color builds for spot colors that are 
converted to CMYK, overprint and knockout settings, line screens, and 
screen angles, and you can map spot colors to print with other colors.

Colors
The Colors column lists all colors that are present in the job. To prevent a 
color from printing, de-select the check box next to the color name. To 
simultaneously set all colors to print or not to print, click All Colors On or 
All Colors Off. 
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Build
You can change the process color build for spot colors that have been 
converted to process builds. This feature can be used when you have source 
files from different applications, and the applications have defined the 
process equivalent of the same spot color differently. 

Output As
When working with DSC-compliant composite input files, you can print 
any spot color on the same plate as any other color in the job, or convert it 
to a process build. You can convert the colors individually, or click All 
Spots As Process or All Spots Separately to change all colors in the job 
simultaneously.

Overprint/Knockout
Preps has three overprint options. You can select a different option for each 
color. 

Pass through
Retains the overprint that was applied by the application that created the 
source files.

Knockout
Knocks out the selected color from all other separations. If knockout is 
applied, any overprint information for the selected color in the composite 
source file is overridden. This option applies to all screen values of the 
selected color. 

Overprint
Forces the selected plate color to overprint all other plate colors. This 
option works only for composite source files that were created without 
overprint instructions for black plate information. This option applies to 
all screen values of the selected color.



Color Separations Tab 157

Line Screen and Screen Angle
You can choose line screens and screen angles for each color in the Colors 
list. The default line screens and screen angles vary, depending upon the 
selected output device.

Add Color
If a source file does not contain adequate DSC comments about a color, 
Preps does not receive information about the color and cannot display it 
on the Color Separations tab. You can, however, manually add the color to 
the Colors list by typing in the name of the color exactly as it appears in the 
source document.

Halftone Settings - Spot Shape
You may change the halftone spot shape for all the colors can the job. The 
available halftone spot shapes options are in the PPD or PPX file for the 
selected output device.
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Level 2 Options

Overview
Level 2 Options work with the selected output device to:

• Enable PostScript Level 2 color separations

• Enable PostScript Level 2 forms optimization

• Change the default settings for forms optimization (for advanced users 
only and not described here)

Color Separations
You have two options for printing color separations from Preps:

• Using Preps’ built-in color-separation engine (host-based separations)

• Using PostScript Level 2 in-RIP color separations

Preps uses a PostScript Level 1 color separator, which allows you to control 
how the output is separated, including screen angles, mapping one spot 
color to another, and converting spot colors to process. This option works 
only with source files that are PostScript Level 1.

Preps also supports color separation in the RIP for Level 2 PostScript 
devices that support this functionality. You have the same control over how 
the output is separated as you do with Preps’ color separator, but the 
output from Preps is a composite file that is separated by the RIP. You must 
use this option if your source files are PDFs, or if they are PostScript files 
that contain Level 2 or PostScript 3 information.

1. From the Setup menu, select Device Setup.
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2. In the Device Setup dialog box, select the output device.

3. Click Device Configuration.

4. Click Level 2 Options.

5. Select the Enable PostScript Level 2 color separations check box.

6. Click OK.

This enables the Color Separation: In-RIP option on the General tab in the 
Print dialog box.
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Module Wrap-Up
In this module, you learned to:

• Describe the five output options

• Print imposed output to a printer, create a PostScript file, output an 
Adobe Job Ticket, discard the output, create a Job Description File 
(JDF), and/or create a CIP3 cutting data file (PPF)

• Specify a print range, output format, imaging options, and halftone 
screening

• Specify color separations

• Enable PostScript level 2 options
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Module Objectives
By the end of this module, you will be able to:

• Describe the Preps PDF native workflow

• Create a PDF native job and print it to a PDF file
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Native PDF Workflow

Overview
Preps 4.0 and later allows you to work in native PDF format. This means 
you use PDF source files and output PDF from Preps. Using a PDF 
workflow is very similar to a PostScript workflow, with a few exceptions:

• You use the same templates you use for PostScript or mixed-file 
workflows, but any custom EPS marks you place must also have PDF 
versions (most marks that ship with Preps have PDF equivalents)

• Input (source) files and output must be composite

• No font handling occurs

• No OPI processing occurs

• The following on-demand features are not supported: finishing and 
duplexing settings, Choose Media features, tab sheets, and slip sheets

Template Marks
You create templates using the EPS or TIFF marks. When you print a PDF 
native job out of Preps, the PDF marks are automatically substituted for 
the EPS or TIFF marks. This allows you to have generic templates that can 
be used in either a PDF or mixed workflow. 

Preps provides PDF versions of some of the standard template marks—
specifically, the static marks (the marks that don’t change based on output 
device or on instructions that come from the PostScript in a mixed-files 
job). 

Some of the dynamic EPS marks, such as sigcolla.eps, sigcollb.eps, etc., 
cannot be used with PDF native jobs, although the “built-in” collation 
marks (such as Signature Collation Mark A) work correctly. 

Custom EPS marks can be used, provided a PDF equivalent of the mark is 
present in the Marks folder. You create a PDF version of an EPS mark either 
by exporting from the native application in which you created the EPS, or 
by using Adobe Acrobat Distiller to create a PDF. Using the latter method 
may require that you open the PDF in Adobe Acrobat and use the cropping 
tool to crop it to its correct size; Distiller cannot create a PDF smaller than 
1" x 1".
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See the Preps 5.0 User Guide for more information on creating PDF versions of 
custom marks
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Scenario

The following activity teaches you how to create a PDF native job and print 
it to a PDF file. (Metric versions are shown in parentheses.) You add PDF 
files to a job the same way you add any source files (see Module 1, Working 
With Jobs).

1. From the File menu, choose New Job, then PDF -> PDF.

2. From the Learning Preps:Activity Files:Art of Imagery:PDF:US 
(Metric) folder, add to the file list the following files (or their metric 
equivalents):

Cover.pdf

Frontmatter.pdf

Chapter1_11pg.pdf

Chapter2_12pg.pdf

Backcover.pdf

Activity

Activity 1: Creating a PDF Native Job
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3. Add the files to the run list in the order listed above.

4. In the Signature List window, click Signatures.

5. From the Templates:Sample Templates:US (Metric) folder, select the 
Saddle Stitched binding style, then select Letter Tutorial Saddle (A4 
Tutorial Saddle). 

6. Click Auto Select. You should see two 16 page SW signatures in the 
list at the bottom of the window.

7. Click OK.

8. From the File menu, choose Print.

9. From the Send to list, select PDF File.

10. Click Print.

11. In the Save dialog box, in the Save As box, type a name for the output 
file.
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12. From the Where list, select a location to save the PDF.

13. Click Save.

14. To view the file, locate the PDF file, and open it in Adobe Acrobat.
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Module Wrap-Up
In this module, you learned to:

• Describe the Preps PDF native workflow

• Create a PDF native job and print it to a PDF file
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